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1. INTRODUCTION 94 

 95 

 96 

 GENERAL INFORMATION ABOUT ENTSOG TRANSPARENCY PLATFORM 97 

 98 

Regulation (EC) № 715/2009 and its amendments require ENTSOG to provide a Union-wide 99 

platform where all Transmission System Operators for gas shall make their relevant data publicly available. 100 

The first common platform has been set up by the TSOs on a voluntary basis in 2008 and then improved 101 

in 2013 in order to comply with changed Transparency regulation requirements (Chapter 3 of Annex №1 102 

to Regulation (EC) № 715/2009 and its amendments). 103 

 104 

On 1 October 2014, ENTSOG launched a new Transparency Platform. 105 

 106 

By providing free of charge vast information related to gas transmission in an organised and structured 107 

way, the platform is a further contribution by TSOs for gas to enhance transparency in the European energy 108 

market. 109 

 110 

The Transparency Platform provides technical and commercial data on gas transmission systems, which 111 

include interconnection points and connections with storages, LNG facilities, distribution networks, final 112 

consumers and production facilities. 113 

 114 

The platform is available on web address: https://transparency.entsog.eu  where the interested parties 115 

are able to access valuable information uploaded by all TSOs. 116 

 117 

 118 

 AIM OF THIS DOCUMENT 119 

 120 

The purpose of this document is to give an overview of ENTSOG Transparency Platform (hereinafter 121 

referred to as “TP” or as the “Platform”) as well as some practical tips and information on how to use its 122 

functionalities. 123 

 124 

 125 

 SYSTEM REQUIREMENTS FOR USING ENTSOG TRANSPARENCY PLATFORM 126 

 127 

ENTSOG recommends that you visit its Transparency Platform using a modern web or mobile browser 128 

(Internet Explorer 10 or later, latest versions of Chrome or Mozilla Firefox). 129 

 130 

 131 

 132 

 133 

 134 

 135 

 136 

https://transparency.entsog.eu/


 137 

2. GENERAL STRUCTURE OF ENTSOG TRANSPARENCY PLATFORM  138 

 139 

 140 

The main structure elements of ENTSOG Transparency Platform are: 141 

 142 

> MENU BAR 143 

> SEARCH BAR 144 

> ROLLING BANNER 145 

> MAP 146 

> DATA PART 147 

 148 

In the next chapters of this manual you will find a detailed description of each structure element and its 149 

parts. 150 

 151 

 152 

 153 

 154 

 155 

 156 

 157 

 158 

 159 

 160 

 161 

 162 

 163 

 164 

 165 

 166 

 167 

 168 

 169 

 170 

 171 

 172 

 173 

 174 

 175 

 176 

 177 

 178 

 179 

 180 



 181 

3. MENU BAR 182 

 183 

 184 

The menu bar provides direct access to the main TP menus. 185 

 186 

 187 
 188 

 189 

 MENU POINTS 190 

 191 

 192 
 193 

Through the Points menu you can access: 194 

▪ TP map - showing all relevant points;  195 

▪ Tool for advanced point search; 196 

▪ Data part of the Platform dedicated for Point information – providing graphical and numerical data 197 

about all indicators for the selected point(s). 198 

 199 

 200 

 MENU ZONES 201 

 202 

 203 
 204 

Through Zones menu you can access: 205 

▪ TP map - showing all Balancing Zones; 206 

▪ Tool for advanced zone search; 207 

▪ Data part of the Platform dedicated for Zone information - providing graphical and numerical data 208 

for the selected zone(s). 209 

 210 



 211 

 MENU OPERATORS 212 

 213 

 214 
 215 

The Operators menu leads the TP user directly to a sub-page listing all TSOs that are participating and 216 

publishing data on the TP. 217 

 218 

 219 
 220 

 221 

A separate tab is dedicated for each TSO: 222 

 223 

 224 
 225 

By clicking on an individual TSO tab, a pop-up opens with information and access to: 226 

▪ TSO’s web site transparency section; 227 

▪ Links to specific sections on TSO’s web site with information on applied tariff, tariff calculator, 228 

maintenance information, capacity data, access conditions and etc.; 229 



▪ General information and contact details for the TSO; 230 

▪ List of TSO’s Points; 231 

▪ List of TSO’s Balancing Zones; 232 

▪ Balancing information for the TSO; 233 

▪ Capacity information for the TSO; 234 

▪ Tariff information for the TSO. 235 

 236 

 237 
 238 

 239 

 MENU CALENDAR 240 

 241 

 242 
 243 

The Calendar menu leads the TP user to a sub-page providing information about the planned and non-244 

planned interruptions and Urgent Market Messages, published by all or selected TSO(s) for a certain 245 

configurable by the user period (month, week or day).  246 

 247 

 248 
 249 

The colour of the information on the Calendar depends on the type of information presented. The colour 250 

code for the different type of announced interruptions is:  251 

 252 

 253 

 254 



 255 

Colour code Type of information 

Red Urgent Market Messages 

Red Unplanned interruption of Firm Services 

Orange Planned Interruptions of Firm Services 

Blue Planned Interruptions of Interruptible Capacity 

Grey Actual Interruptions of Interruptible Capacity 

 256 

 257 

 258 
 259 

 260 

 MENU SUBSCRIBE 261 

 262 

 263 
 264 

The Subscribe section allows the TP users to sign up for RSS feeds to receive announcements about new 265 

publications in the following rubrics: 266 

▪ Urgent Market Messages; 267 

▪ Planned Interruptions of Firm Services; 268 

▪ Unplanned Interruptions of Firm Services; 269 

▪ Planned Interruptions of Interruptible Capacity; 270 

▪ Actual Interruptions of Interruptible Capacity. 271 

 272 



 273 
 274 

 275 
 276 

ENTSOG provides to the TP users an Automated Download Tool. 277 

A user guide with details on how to configure ENTSOG TP REST APIs and to set up direct download of 278 

information published on the Platform, bypassing any web layer, is accessible through the SUBSCRIBE -> 279 

API MENU. 280 

 281 

 282 

 MENU HELP 283 

 284 

 285 
 286 

The Help menu opens a sub-page with Frequently Asked Questions, tips and user manual for the ENTSOG 287 

Transparency Platform. 288 

 289 



 290 
 291 

 292 

 MENU LOGIN 293 

 294 

 295 
 296 

The Login menu provides access for the Registered TP users to some additional functionalities of the 297 

Platform: 298 

▪ To create groups of Favourite objects – valid for all Registered TP users; 299 

▪ To publish REMIT messages (UMMs) – valid only for TSO Registered TP users upgraded to REMIT 300 

users. 301 

 302 

After login, the Registered TP user can verify the user details and change its login password: 303 

 304 

 305 
 306 

 307 

 308 

 309 

 310 

 311 



 FAVOURITES MENU 312 

 313 

The Favourites menu is available only for Registered and logged-in TP users. 314 

 315 

 316 
 317 

 318 
 319 

When logged-in, the TP user has access to all TP features and functionalities available to other users. In 320 

addition, the logged-in user can create one or many groups of “favourite” objects. The user-defined groups 321 

provide fast access (shortcuts) to the data related to “favourite” objects.  322 

 323 

 324 
 325 

A new group of favourite objects can be created through the button “Create new group”: 326 

 327 

 328 
 329 

To add a point/object as “favourite” in one of the user-defined groups, type the name of the point/object 330 

in the Search bar. During the typing process a drop-down menu with a list of the objects which match the 331 

typed name appears below the Search bar. 332 

 333 

 334 

 335 

 336 



Select the preferred point/object by clicking the Star  symbol next to the name of the object: 337 

 338 

 339 
 340 

Test example of user defined group of favourite points: 341 

 342 

 343 
 344 

 345 

 346 

 347 

 348 

 349 

 350 

 351 



The data for a group or favourite objects can be accessed through the Bar chart  symbol: 352 

 353 

 354 

A user defined group of favourite objects can be deleted using the X-crossing  symbol: 355 

 356 

 357 
 358 

 359 
 360 

Another possibility for a logged-in Registered TP user to make a point or zone a favourite object is to select 361 

it from the Recently Viewed Items (Left Map Sidebar) by clicking on the Start  symbol next to the name 362 

of the object of interest:  363 

 364 

 365 



 366 
 367 

Once you have defined your favourites, you can export related data easily using the Point Export Wizard 368 

(Please refer to the Export Wizard section 7.4.6. for more details). 369 

 370 

 371 
 372 

How to become Registered TP user? 373 

 374 

 375 
In order to become Registered TP user: 376 

1. Select the menu Login; 377 

2. Press on the link Request credentials; 378 

3. Fill in the required information; 379 

4. Accept the Terms and conditions of use; 380 

5. Press the button Register; 381 

6. The login credentials will be sent to the email address pointed during the registration process. 382 

 383 



 384 
 385 

 386 

 387 

 388 

 389 

 390 

 391 

 392 

 393 

 394 

 395 

 396 

 397 

 398 



4. ROLLING BANNER 399 

 400 

 401 

 402 
 403 

The Rolling banner shows dynamically information about the valid for the current period interruptions: 404 

▪ Urgent Market Messages; 405 

▪ Planned Interruptions of Firm Services; 406 

▪ Unplanned Interruptions of Firm Services; 407 

▪ Planned Interruptions of Interruptible Capacity; 408 

▪ Actual Interruptions of Interruptible Capacity. 409 

 410 

Only the most recent messages, impacting the TSOs networks currently and/or in the future, are displayed. 411 

 412 

 413 
 414 

Click on the Rolling banner to display the details of the message currently shown. 415 

 416 

 417 



 418 
 419 

The colour of the Rolling banner changes depending on the type of information presented. The messages 420 

valid for the current period visualised in the Calendar section are displayed consecutively on the Rolling 421 

banner. The colour code of the Rolling banner repeats the colour code of each particular message from 422 

the Calendar area:  423 

 424 

Colour code Type of information 

Red Urgent Market Messages 

Red Unplanned interruption of Firm Services 

Orange Planned Interruptions of Firm Services 

Blue Planned Interruptions of Interruptible Capacity 

Grey Actual Interruptions of Interruptible Capacity 

 425 

 426 

 427 
 428 

 429 

 430 

 431 

 432 

 433 

 434 

 435 

 436 

 437 

 438 

 439 

 440 

 441 

 442 

 443 



5. MAP 444 

 445 

 446 

 447 
 448 

The Transparency Platform Map is accessible from several TP sections: 449 

▪ From the TP home page; 450 

▪ From the menu Points; 451 

▪ From the menu Zones. 452 

 453 

The map displays all the points configured for visualisation by ENTSOG. Please note that it does not 454 

necessarily display all the points accessible through the Search bar.  455 

 456 

 457 
 458 

By default, the map on the TP home-page shows only Transmission points and operational pipelines in 459 

Europe. 460 

 461 



 462 
 463 

To show all relevant points on the map for which the TSOs are publishing data on the TP, click once on the 464 

POINT menu button. 465 

 466 

 467 
 468 

 469 
 470 

To show on the map the Balancing Zones configured on ENTSOG TP, simply click once on the ZONE menu 471 

button. 472 

 473 

 474 



Alternatively, go to ZONES menu and select MAP. 475 

 476 

 477 
 478 

Each of the Balancing Zones is indicated by an orange point  479 

 480 

 481 
 482 

 483 
 484 

If you press and hold the primary mouse button on the screen, you can drag and move the map on the 485 

display to focus on a particular area.  486 

 487 

 488 



 MAP OBJECTS 489 

 490 

The Map can display the following objects: 491 

▪ Points; 492 

▪ Balancing Zones; 493 

▪ Pipelines; 494 

▪ Locations; 495 

▪ Gas fields; 496 

▪ Drilling platforms. 497 

 498 

The visualisation of these objects is configurable through map filtering and display setting options from the 499 

right side bar of the map (Please refer to the explanation in point 5.2. Right Sidebar Menu). 500 

By clicking on particular map point or zone symbol a pop-up window appear. 501 

 502 

Point pop-up: 503 

 504 

 505 
 506 

 507 

 508 

 509 

 510 

 511 

 512 

 513 

 514 



Zone pop-up: 515 

 516 

 517 
 518 

 POINT POPUPS 519 

 520 

When clicking on a point a pop-up window appears. It contains information about the: 521 

 522 

▪ Point name; 523 

▪ Point type: 524 

○ Physical; 525 

○ Virtual; 526 

▪ Type of points based on their function: 527 

○ Cross-border Transmission IP within EU; 528 

○ Cross-border Transmission IP between EU and Non-EU; 529 

○ Storage IP; 530 

○ Cross-Border Storage IP within;  531 

○ LNG Entry IP; 532 

○ Trading point; 533 

○ Transmission point; 534 

○ Final Customers point; 535 

○ Production IP; 536 

○ Distribution IP; 537 

▪ Point EIC; 538 

▪ Booking platform information; 539 



▪ Connected operators; 540 

▪ Connected Balancing Zones; 541 

▪ Point information per direction incl. CAM/CMP relevance 542 

 543 

 544 

 545 
 546 

If the point is operated as Pipe-in-Pipe with more operators, this will also be mentioned in the Point 547 

Information pop-up.  548 

 549 

 550 

 551 
 552 

The pop-up window of the virtual interconnection points (VIP) provides more details. The VIP pop-up 553 

contains information for the virtual point and for the virtualised physical points. 554 
 555 



 556 
Each point direction is presented by a tab in the point pop-up window. 557 

The pop-up of a unidirectional point (entry only or exit only) has only one tab, respectively the pop-up of 558 

a bidirectional point has two tabs. 559 

 560 

 561 
 562 

 Point pop-up of a unidirectional point: 563 

 564 

 565 
 566 

 567 



 568 

The bidirectional points have two tabs – one for each point direction: 569 

 570 

 571 
 572 

You can switch between the tabs simply by changing your selection. 573 

 574 
 575 

 576 
 577 

When a physical point has been virtualised, the point pop-up shows the name of the virtual point in which 578 

the physical point was included following virtualisation, as well as additional information about the start 579 

date of the virtualisation and details on capacity marketing: 580 

 581 



 582 
 583 

 584 
 585 

You can access the data published by the respective operators for the point either by selecting the Bar  586 

chart  symbol next to the balancing zone name or by clicking on the Access data page button587 

. 588 

 589 
 590 

 591 
 592 

The Plus sign  provides fast access to information about the physical flow and the technical capacity of 593 

the point for the selected direction during the current gas day. 594 



When clicking on the Plus sign a drop-down menu appears and the sign turns to Minus  595 

 596 

 597 
 598 

 ZONE POPUPS 599 

 600 

When clicking on a zone symbol a pop-up window appears which contains information about the: 601 

▪ Zone name; 602 

▪ Zone EIC; 603 

▪ All entry points of the zone; 604 

▪ All exit points of the zone; 605 

▪ Information of the aggregated entries to adjacent zones; 606 

▪ Information of the aggregated exits to adjacent zones. 607 

 608 

The data is accessible via several tabs: 609 

▪ Entry points tab – lists all entry points to the zone, as well as the adjacent Balancing Zones and 610 

operators;  611 

▪ Exit points tab – lists all exit points from the zone, as well as the adjacent Balancing Zones and 612 

operators;  613 

▪ Aggregate entries tab – lists the adjacent Balancing Zones and operators in the entry direction of 614 

the zone; 615 

▪ Aggregate exits tab – lists the adjacent Balancing Zones and operators in the exit direction of the 616 

zone. 617 

 618 

 619 



 620 

 621 

 622 
 623 

The navigation details of zone pop-ups repeat the navigation functions described earlier in point 5.1.1 for 624 

point pop-ups.   625 

 626 

 627 
 628 

The Plus sign  at entry/exit points tabs provides fast access to information about the physical flow and 629 

the technical capacity of the zone for a selected direction, during the current gas day. 630 

When clicking on the Plus sign a drop-down menu appears and the sign turns to Minus  . 631 

 632 



 633 

The Plus sign  at the aggregate entries/exits tabs provides fast access to information about the physical 634 

flow for a selected direction, during the current gas day. 635 

 636 

 637 
 638 

 639 

 RIGHT SIDEBAR MENU 640 

 641 

The information displayed on the Map is configurable through the Sidebar menu accessible on the right 642 

side of the screen. 643 

 644 



 645 
 646 

 647 

The Sidebar menu provides access to the following tools: 648 

▪ Zoom In and Zoom Out tool; 649 

▪ Full Screen map; 650 

▪ Display settings of the map; 651 

▪ Filters of the information on the map; 652 

▪ Legend of the map symbols and colour codes. 653 

 654 

 ZOOM 655 

 656 

The map can be Zoomed In and Zoomed Out through a sidebar buttons: 657 

 658 

 659 
 660 

 ZOOM IN 661 

 662 



Using the Zoom In function, the TP user can get a closer view of a chosen area on the map: 663 

 664 

 665 
 666 

 667 
 668 

If the primary button mouse is double-clicked on the map it has a Zoom In effect.  669 

If the mouse is scrolled forward it has a Zoom In effect. 670 

 671 

 ZOOM OUT 672 

 673 

Through the Zoom Out function the TP user can return to a more general outline of the map: 674 

 675 

 676 
 677 



 678 
 679 

Scrolling the mouse backwards has a Zoom Out effect. 680 

 681 

 682 

 683 

 684 

 685 

 686 

 687 

 688 

 689 

 690 

 691 

 692 

 693 

 FULL SCREEN 694 

 695 

 696 
 697 

The Full Screen button on the Sidebar allows the TP user to expand the view of the map on the whole 698 

screen.  699 

 700 



 701 
 702 

 703 
 704 

If the mouse is double-clicked on the map it has a Zoom In effect. 705 

If you press and hold the primary mouse button on the screen, you can drag and move the map on the 706 

screen.  707 

To return from Full Screen map view to normal TP mode, press the ESC key on the keyboard.  708 

 709 

 DISPLAY SETTINGS 710 
 711 

The information shown on the map can be managed through the Display settings menu. 712 
 713 

 714 
 715 

The Display settings menu allows users to show or hide the following categories of details on the map: 716 

▪ Gas fields; 717 



▪ Drilling platforms; 718 

▪ Projected points and pipelines; 719 

▪ Small pipelines; 720 

▪ Medium pipelines; 721 

▪ Large pipelines; 722 

▪ Country names; 723 

▪ Location names. 724 
 725 

 726 

 727 
 728 

This is an example depicting the relevant points and only the large pipelines with a diameter bigger than 729 

900 mm in Europe: 730 

 731 



 732 
 733 

 734 

 FILTERS 735 

 736 

 737 
 738 

The Filters menu allows users to filter the information to be displayed on the map. The user can select to: 739 

▪ Show or hide all connection points on the map; 740 

▪ Show and hide all Balancing Zones on the map; 741 

▪ Display only Operational points or only Projected points; 742 

▪ Display only Interconnection points, or only Trading points or only Cross-border points; 743 

▪ Display only the points within EU, or only the NON-EU points, or the connection points between EU 744 

and NON-EU countries; 745 

▪ Filter the points shown on the map depending on the type of the infrastructure they are connected 746 

to, i.e. to display only the connection points to Distribution systems; or only the connection points to 747 

Transmission systems,  or only the connection points to Final consumers,  or only the connection points 748 

to Storage facilities, or only the connection points to Transmission systems,  or only the connection 749 

points to Production facilities, or only Trading points or only the Entry points from LNG Terminals.   750 



▪ Show information for one selected TSO or for all TSOs; 751 

▪ Show information for one selected Balancing zone or for all Balancing Zones; 752 

▪ Show information for one selected country or for all countries; 753 

▪ Show only CAM-Relevant points or only  NON CAM-Relevant points; 754 

▪ Show Balancing Zones of selected country. 755 
   756 

 757 

 758 
 759 

Example for filtering the points displayed on the map to: 760 

Cross-border transmission points of Germany which are CAM-Relevant, plus the available Balancing Zones 761 

in Germany. 762 

 763 



 764 
 765 

 766 

 LEGEND 767 

 768 

 769 
The Legend shows the meaning of the symbols and colour codes used on the map. 770 

 771 



 772 
 773 

 774 

 775 

 776 

 777 

 778 

 779 

 780 

 781 

 LEFT SIDEBAR - RECENTLY VIEWED ITEMS 782 

 783 



The Left hand sidebar consists of a single button providing direct access to the Recently Viewed Items. 784 

 785 

 786 
 787 

 788 
 789 

As Recently Viewed Items will be shown the objects for which you have recently explored information, 790 

searched through the Search bar or clicked on the map. 791 

 792 

 793 

 794 

 795 

 796 

 797 

 798 

 799 

 800 

 801 

 802 

 803 

 804 

 805 

 806 

 807 

 808 

 809 

 810 

 811 

 812 

 813 

 814 



 815 

By clicking on the Current button , the TP user can get access to the recently explored by him/her 816 

objects (points, zones) on the TP. 817 

 818 

 819 
 820 

The Recently Viewed Items sidebar has two tabs: 821 

 822 

 823 
 824 

The tab Points contains a list of the recently viewed points. 825 

The tab Zones contains a list of the recently viewed zones. 826 

 RECENTLY VIEWED POINTS 827 

 828 

The Points tab displays the last twenty points that you have visited (e.g. clicked on, searched and explored).  829 

 830 



 831 
 832 

 833 

 UNFOLDING ADDITIONAL POINT INFORMATION 834 

 835 

Each point can be unfolded. By clicking on a point name, information for connected at that point 836 

Operators, Balancing Zones and available point Directions will be shown.  837 

 838 



 839 
 840 

The level at which the connected Balancing Zones are denoted is named “Arc level”: 841 

 842 

 843 
 844 

The level at which the connected operators and respective point directions are listed is named “Operators 845 

level”: 846 

 847 

 848 



 DIRECTION INDICATORS 849 

 850 

The available point directions are marked with arrows: 851 

 Exit point direction for the selected operator; 852 

 Entry point direction for the selected operator. 853 

 854 

 855 

 ACCESS TO DATA PART 856 

 857 

If you click on the Bar chart  symbol at the Arc Level, you can get access to the data published by both 858 

connected operators for the point. 859 

In the example below, you will get direct access to the data published by GASCADE in exit direction and by 860 

OGE for entry direction of the point Lampertheim I. 861 

 862 

 863 
 864 

To hide the data displayed on the data panel you click once again on the Bar chart  symbol at Arc Level.  865 

In order to hide the information published by GASCADE and to leave on the screen only the graph for the 866 

OGE data, press on the Minus sign  symbol next to GASCADE name at Operators level. 867 

      868 

If you click on a Bar chart  symbol at Operators level, you will display the information published by the 869 

respective operator - in the example below -  the information published by GASCADE in exit direction for 870 

the point Lampertheim I. 871 



 872 
 873 

If you would like to display the information published by the adjacent operator, click on the Bar chart 874 

symbol or on the Plus  sign next to its name. In the example below – click on the Bar chart or Plus sign 875 

symbol next to OGE name at Operator level. 876 

 877 

 878 
 879 

 880 
 881 

Clicking on the Bar chart  symbol in the Recently Viewed Items will always clean up the previously 882 

displayed chart content. For Example, if the chart displayed ten series before, clicking on the Bar chart 883 

symbol will remove these ten series and then show your new selection. 884 

You can add or remove data series selectively, by using the  /  buttons. This will not clean up any 885 

previously displayed content in the chart. 886 

The selection in Recently Viewed Items applies to all the tabs in the Points Data page. 887 



You can remove a point from the list of Recently Viewed Items by clicking on the Cross  symbol next to 888 

its name: 889 

 890 

 891 
 892 

If you are a Registered TP user and you are logged in to your TP user profile, you can add as “favourite” 893 

item a point listed in the Recently Viewed Items by clicking on the Star  symbol: 894 

 895 

 896 
 897 

By clicking on the Balloon  symbol next to the name of the point in the list of Recently Viewed Items you 898 

can get it visualised on the TP map: 899 

 900 

 901 
 902 

 903 

 904 

 905 



To clear the list of the Recently Viewed points, press on the button “Clear all points”: 906 

 907 

 908 
 909 

 910 

 RECENTLY VIEWED ZONES 911 

 912 

The Zones tab displays the recently visited by the TP user Balancing Zones.  913 

 914 

 915 
 916 

 917 

 918 

 919 

 920 

 921 

 922 

 923 

 924 



 UNFOLDING ADDITIONAL ZONE INFORMATION 925 

 926 

For each zone listed in the Recently Viewed Items additional information can be displayed.  927 

By clicking on a zone name, information about the Operator(s) that belong to the selected Balancing Zone 928 

and the adjacent Balancing Zones is unfolded. The unfolded items present all aggregated entries and exits 929 

to and from the selected Balancing Zone and its adjacent zones. 930 

 931 

 932 

 933 
 934 

 935 

 DIRECTION INDICATORS 936 

 937 

The flow direction between the adjacent zones is shown by the following direction arrow signs: 938 

 Aggregated exits out of the selected balancing zone and operator; 939 

 Aggregated entries into the selected balancing zone and operator. 940 

 941 

 942 

 ACCESS TO DATA PART 943 

 944 

By clicking on the Bar chart symbol   or Plus  sign next to the name of selected adjacent Balancing 945 

Zone you can directly access the data published by the respective operator for the flow between two 946 

Balancing Zones. 947 



 948 
 949 

 950 

 951 

You can remove a zone from the list of Recently Viewed Items by clicking on the Cross  symbol next 952 

to its name: 953 

 954 

 955 
 956 

By clicking on the Balloon  symbol next to the name of the zone in the list Recently Viewed Items you 957 

can get it visualised on the TP map: 958 

 959 



 960 
 961 

 962 

To clear the list of the Recently Viewed Zones, press on the button “Clear all zones”: 963 

 964 

 965 
 966 



The figure in brackets next to the zone name shows the number of the aggregated entries and exits to and 967 

from the selected Balancing Zone. 968 

 969 

 970 
 971 

 972 

 973 

 974 

 975 

 976 

 977 

 978 

 979 

 980 

 981 

 982 

 983 

 984 

 985 

 986 

 987 

 988 

 989 

 990 

 991 



 REDIRECTION OPTIONS 992 

 993 

 994 
 995 

How to access TP Data Part from the TP Map? 996 

 997 

There are many possibilities to access TP data from the Map. 998 

 999 

▪ Through POINT menu - > DATA submenu: 1000 

 1001 

 1002 
 1003 

 1004 

▪ Through ZONE menu - > DATA submenu: 1005 

 1006 

 1007 
 1008 

 1009 

▪ By searching for an object through the SEARCH BAR:  1010 

Select the item of interest from the drop-down menu that appears and click on the bar chart 1011 

symbol: 1012 

 1013 



 1014 
 1015 

 1016 

▪ Through the left sidebar – Recently Views Items: 1017 

Select and unfold an item of interest from the Recently Views Items. Click on a Bar chart symbol to 1018 

get direct access to the data for particular operator/direction: 1019 

 1020 

 1021 



▪ Through Map point pop-up: 1022 

Click on a selected point on the map. By clicking on a Bar chart symbol on the Point pop-up you 1023 

can access the data published by particular operator for the selected point direction: 1024 

 1025 

 1026 
 1027 

 1028 

▪ Through Map zone pop-up: 1029 

Click on a selected zone on the map. Through the Zone pop-up you can get access to data about 1030 

the points and adjacent zones connected to the selected Balancing Zone: 1031 

 1032 

 1033 
 1034 

 1035 

 1036 

 1037 

 1038 

 1039 

 1040 

 1041 



6. SEARCH BAR AND ADVANCED SEARCH FUNCTIONS 1042 

 1043 

 SEARCH BAR 1044 

 1045 

 1046 
  1047 

  1048 

 1049 
 1050 

Through the Search bar the TP user can search for a point, balancing zone, operator, country or location 1051 

by using the EIC code, the name or part of the name of the object in interest. 1052 

The search results will return a drop-down menu listing the objects with match of the searched 1053 

information. 1054 

 1055 

 1056 



In the case of network point search, during the name input, a drop-down menu appears below the Search 1057 

bar showing information about the point, operator(s) and zone(s) to which the point belongs. 1058 

 1059 

 1060 
 1061 

 1062 

 1063 

 1064 

 1065 

 1066 

 1067 

 1068 

 1069 

 1070 

 1071 

 1072 

 1073 

 1074 

 1075 

 1076 

 1077 

 1078 

 1079 

 1080 

 1081 

 1082 

 1083 



 1084 
 1085 

In the case of an exact match between the searched and an existing on the platform network point name, 1086 

after clicking ENTER, the point is shown on the map. 1087 

 1088 

 1089 
 1090 

 1091 

 1092 

 1093 

 1094 

 1095 

 1096 

 1097 

 1098 

 1099 

 1100 

 1101 



 1102 
 1103 

When searching for a point through the Search bar, during the name input, a drop-down menu appears 1104 

below the bar. Detailed information on point, including values published by the relevant TSOs for the 1105 

required indicators, can be accessed directly from this drop-down menu. 1106 

 1107 

 1108 
 1109 

To access the point transport data:  1110 

 1111 

1. Press on the name of the connection point shown on the drop-down menu; 1112 

2. Choose the point direction and select the TSO whose information shall be displayed: 1113 

 1114 



 1115 
 1116 

 1117 

 1118 
 1119 

As you can see, there are different levels displayed under a point name in the shown drop-down menu: 1120 

▪ Level 1 – Arc level: 1121 

It shows which Balancing Zones or infrastructures are connected by the point.  1122 

Next to this line, a chart symbol is always displayed.  1123 

 1124 

 1125 
 1126 

 1127 



▪ Level 2 – Operators level: 1128 

It shows which operators are connected in this the respective Arc, and what is their relative flow 1129 

direction. A chart symbol is displayed if the operator mentioned publishes data in this direction.  1130 

 1131 

 1132 
 1133 

Clicking on the chart symbols will have a different effect depending on their position: 1134 

  1135 

> Clicking on the chart symbol at Level 1 redirects you to the “Points Data” page, clears up all previously 1136 

shown data, and displays all the operator flow directions linked to the Arc in Level 1. 1137 

 1138 

> Clicking on the chart symbol at Level 2 redirects you to the “Points Data” page, does not clear up 1139 

previously shown data, but instead adds to these data a new series with the operator flow direction 1140 

selected. 1141 

 1142 

 1143 

 1144 

 1145 

 1146 

 1147 

 1148 

 1149 

 1150 

 1151 

 1152 

 1153 

 1154 

 1155 

 1156 

 1157 

 1158 



 1159 
 1160 

 1161 
 1162 

In the example above, the point “Waidhaus” is shown. Two Arcs are displayed: 1163 

> Czech > NCG; 1164 

> NCG > Czech.  1165 

 1166 

This means that the point can be used to exchange gas either from Czech balancing zone to NCG 1167 

balancing zone, or from NCG balancing zone to Czech balancing zone.  1168 

 1169 

Under the Arc Czech > NCG, we can see three lines: 1170 

> N4G Exit; 1171 

> OGE Entry; 1172 

> GRTD Entry. 1173 

 1174 

This means that one operator (NET4GAS) delivers gas from the Czech balancing zone to two operators  1175 

(OPEN GRID EUROPE, GRTGAZ DEUTSCHLAND) in the NCG Balancing Zone.  1176 

 1177 

 1178 

 1179 

 1180 

 1181 

 1182 



Clicking on the chart symbol next to the “Czech > NCG”: 1183 

 1184 

 1185 
 1186 

will redirect you to the “Points Data” page, and load the data of all three operator lines.  1187 

On this way, you can easily compare the data provided in entry and exit direction, which generally 1188 

should match, unless there are specific circumstances like pipe-in-pipe agreements: 1189 

 1190 

 1191 
 1192 

Clicking on the chart symbol next to “N4G exit”: 1193 

 1194 

 1195 



will redirect you to the “Points Data” page, but will only load the exit data provided by NET4GAS: 1196 

 1197 

 1198 
 1199 

 1200 

 1201 
 1202 

We detected an issue related to the access to the Point Data from the Search bar, when accessing the 1203 

Platform from computers with MS Windows 8.1 Operating system. The problem is related to localStorage 1204 

API. 1205 

To workaround this issue, you have to: 1206 

1. Refresh the page - press F5 key or click on “Reload” button of the browser; 1207 

2. Clear the cache; 1208 

3. Clear the local storage. 1209 

 1210 

Below you can find further instructions on how to clear the cache and the local storage on the most 1211 

common web-browsers: 1212 

 1213 

Browser How to clear the cache? How to clear the localStorage? 

 

o Click on the Gear icon at the top 
right of the browser window and 
select Internet Options; 

o Click Delete under Browsing 
History; 

o Uncheck every box except the 
box for Temporary Internet Files 
in the Delete Browsing History 
window; 

o Click Delete; 
o Click OK. 

Open the navigator console using F12 

Key or via the menu  

Tools > Development tools; 

 

Execute the following commands on the 

console:  

localStorage.clear(); 

sessionStorage.clear(); 



 

o Click on Tools on the menu bar 
and select Clear Recent History; 

o Select everything from the Time 
range to clear drop-down list; 

o Click the down arrow next to 
Details; 

o Click to check the box Cache; 
o NOTE: Make sure to check Cache 

only; 
o Click Clear Now; 
o Click OK; 
o Close and reopen the browser. 

Open the navigator console using F12 

Key or via the menu  

Tools > Web Developer extension; 

 

Execute the following commands on the 

console:  

localStorage.clear(); 

sessionStorage.clear(); 

 

o Click the Chrome Tools icon on 
the menu; 

o Select Options; 
o Click the Under the Hood tab; 
o Click the Clear browsing data  

button; 
o Click to check the Empty the 

cache box; 
o Click the Clear browsing data 

button; 
o Click the Close button; 
o Close and reopen the browser. 

Open the navigator console using 
Ctrl+Shift+J combination or via the 
menu  
Tools > JavaScript Console 
 

Execute the following commands on the 

console:  

localStorage.clear(); 

sessionStorage.clear(); 

 

o Go to a non-LexisNexis webpage; 
o Click the Safari menu and select 

Reset Safari; 
o Click to check the box Empty the 

cache; 
o Click Reset; 
o Close and reopen the browser. 
 

To activate the console:  
o Click the Safari Tools icon on the 

menu; 
o Select Preferences; 
o Select the Advanced Tab; 
o Check checkbox "Show the 

developement pmenu in the Menu 
bar"; 

o Ctrl+Alt+I  or  Ctrl+Alt+C 
 

Execute the following commands on the 

console:  

localStorage.clear(); 

sessionStorage.clear(); 

 1214 

 1215 

 1216 

 1217 

 1218 

 1219 

 1220 

 1221 

 1222 



 ADVANCED SEARCH FUNCTIONS 1223 

 1224 

 1225 

The ENTSOG TP provides to its users Advanced Search possibilities for points and zones.  1226 

 1227 

 1228 

 ADVANCED SEARCH FUNCTIONALITY FOR POINTS 1229 

 1230 

The tool for points advanced search is accessible through POINTS menu -> ADVANCED SEARCH 1231 

 1232 

 1233 
 1234 

The advanced searched options available are: 1235 

▪ Point name; 1236 

▪ From country; 1237 

▪ From zone; 1238 

▪ From infrastructure; 1239 

▪ From operator; 1240 

▪ From operator point; 1241 

▪ From identifier; 1242 

▪ To identifier; 1243 

▪ To operator point; 1244 

▪ To operator; 1245 

▪ To infrastructure; 1246 

▪ To zone; 1247 

▪ To country. 1248 

 1249 

 1250 

 1251 

 1252 

 1253 

 1254 

 1255 

 1256 



To find information based on a certain point you should enter data in the search fields: 1257 

 1258 

 1259 
 1260 

 1261 
 1262 

ENTSOG TP provides direct access to the data published for the point in quest through the Bar chart  1263 

symbol or Access data page button  1264 

By clicking on the Balloon sign from the Point name field the TP will show the point on the map.  1265 

If you are a Registered TP user logged in to your user profile, by clicking on the Star  symbol next to 1266 

the name of the point, you can add it in the list of your favourite objects.  1267 

 1268 

 1269 

 1270 

The columns FROM IDENTIFIER and TO IDENTIFIER also contain a Bar chart  symbol.  1271 

Clicking on the symbol in the FROM IDENTIFIER column will only display the data in the left part of the 1272 

Advanced Search, i.e. all the exits. Clicking on this symbol in the TO IDENTIFIER column will only display 1273 

the data in the right part of the Advanced Search, i.e. all the entries. 1274 

 1275 

 1276 

 1277 
 1278 

In the Advanced Search, filter on “From CC”: DE and “To CC”: FR. You can see that there are two rows - 1279 

two exits from Germany, entering into a single entry point with a single identifier in France. 1280 

 1281 

> Clicking on Access data  button, loads the data for both exit TSOs (Open Grid 1282 

Europe, GRTgaz Deutschland) and entry TSO (GRTgaz); 1283 



> Clicking on the FROM IDENTIFIER column, loads only the exit data from Open Grid Europe and GRTgaz 1284 

Deutschland; 1285 

> Clicking on the TO IDENTIFIER column, loads only the entry data of GRTgaz. 1286 

 1287 

 1288 

 ADVANCED SEARCH FUNCTIONALITY FOR ZONES 1289 

 1290 

The tool for zones advanced search is accessible through ZONES menu -> ADVANCED SEARCH 1291 

 1292 

 1293 
 1294 

The advanced searched options available for requesting a zone are: 1295 

▪ Balancing zone name; 1296 

▪ Country code; 1297 

▪ Operator name; 1298 

▪ Flow direction; 1299 

▪ Name of the adjacent system. 1300 

 1301 

To find information based on a certain zone you should enter data in the search fields: 1302 

 1303 

 1304 
 1305 

The ENTSOG TP provides direct access to the data published for the zone in quest through the Bar chart 1306 

 symbol or Access data page button  1307 

By clicking on the Balloon sign from the Zone name field the TP will show the zone on the map.  1308 

 1309 

 1310 

 1311 

 1312 

 1313 



7. DATA PART 1314 

 1315 

 1316 

 1317 

The Bar chart symbol  is the shortcut to the Transparency Platform Data part, providing information 1318 

on the values of the TP point and zone indicators in numerical or graphical mode. 1319 

 1320 

 1321 
 1322 

The Data part of ENTSOG Transparency Platform can be reached in several different ways. 1323 

 1324 

1. Through the SEARCH BAR by writing the name of the object in quest and clicking the Bar chart 1325 

symbol: 1326 

 1327 

 1328 
 1329 

 1330 

 1331 

 1332 

 1333 

 1334 



2. Through the MAP by selecting the object in quest and clicking on the Bar chart symbol in the Point 1335 

or Zone pop-up window: 1336 

 1337 

 1338 
 1339 

3. Through the left hand sidebar RECENTLY VIEWED ITEMS, by selecting the object of interest and 1340 

clicking the Bar chart symbol next to its name: 1341 

 1342 

 1343 
 1344 

 1345 

 1346 



4. Through POINT menu - > DATA submenu: 1347 

 1348 

 1349 
 1350 

5. Through ZONE menu - > DATA submenu: 1351 

 1352 

 1353 
 1354 

6. Through OPERATORS menu - > TSO NAME Tab - > Zones: 1355 

 1356 

 1357 
 1358 



The DATA PART of ENTSOG Transparency Platform consists of the three panels: 1359 

 1360 

▪ DATA PANEL 1361 

▪ TIME PANEL 1362 

▪ INDICATORS PANEL 1363 

 1364 

 1365 

 1366 

 1367 
 1368 

 1369 

 DATA PANEL 1370 

 1371 

 1372 

 1373 



 1374 
 1375 

The type of the graph for visualisation in the Data panel can be changed through a menu accessible through 1376 

the Gear-wheel symbol  in the Indicator panel: 1377 

 1378 
 1379 

  1380 
  1381 

 Examples of different graph visualisations: 1382 

 1383 

Bar chart 1384 

 1385 

 1386 
 1387 



 1388 
 1389 

 1390 

Stacked Area chart 1391 

 1392 

 1393 
 1394 

 1395 
 1396 

 1397 

Stacked Line graph 1398 

 1399 

 1400 
 1401 

 1402 



 1403 
 1404 

 1405 

 1406 
 1407 

 1408 

How to show information for more than one point simultaneously? 1409 

 1410 

 1411 
 1412 

In case that you are exploring the data for one point and would like to add and display information for 1413 

additional point(s) the easiest way is to use the Search bar. 1414 

 1415 

1. Starting position - You are displaying the data for one point: 1416 

 1417 



 1418 
 1419 

 1420 

2. Next step – Type the name of the new point of interest in the Search bar.  1421 

During the typing process a drop-down menu with list of the objects whose names match to the 1422 

typed name appears below the Search bar. 1423 

 1424 

 1425 
 1426 

 1427 

 1428 



3. Select the searched point by clicking on its name.  1429 

This will unfold additional selection options for this point – point direction, operator publishing 1430 

the data. 1431 

 1432 

 1433 
 1434 

4. Select the point direction and the source of the information and click on the respective Bar chart1435 

 symbol. 1436 

 1437 

 1438 



The information for each point is displayed in different colour. 1439 

The names of the points and their colour codes are shown in a legend below the graph pane. 1440 

 1441 

 1442 
 1443 

 1444 

The same information is presented at the same time in a numerical way in the Transport data tab. 1445 

 1446 

 1447 
 1448 

 1449 

 1450 

 1451 

 1452 

 1453 



 1454 
 1455 

Another possibility to show information for more than one point simultaneously, is to use the Recently 1456 

Viewed Items sidebar. This option would work if the points of interest were explored by the user during 1457 

the current working session and respectively presented in the Recently Viewed Items list. 1458 

The Recently Viewed Items list contains the object recently searched or observed on the TP. 1459 

When the Recently Viewed Items list is populated with objects of interest, in order to display their data 1460 

just press the Bar chart symbol at Arc or Operator level, or click on Plus  sign next to the operator 1461 

name. To show data for other point(s)/direction(s), simply click on the respective Plus sign. 1462 

 1463 

 1464 



 1465 
 1466 

 1467 

The information for the different points is represented by a different colour on the Data pane: 1468 

 1469 

 1470 
 1471 

 1472 

 1473 

 1474 

 1475 

 1476 

 1477 

 1478 

 1479 



The data for the selected points is presented in the Transport data pane: 1480 

 1481 

 1482 
 1483 

 1484 
 1485 

Once you have displayed on the graph information for more than one point, by clicking on the name of 1486 

the points in series you can hide and show the information for the point(s). For details, see the example 1487 

below. 1488 

 1489 

 1490 
 1491 

Example for visualisation of Nomination information for 4 points simultaneously. The points of interest are 1492 

listed in the legend below the graph: 1493 



 1494 
 1495 

Examples of hiding the Nomination information for 2 of the points and displaying data for the remaining 2 1496 

points from the previous illustration.  1497 

The information for the points in grey are is hidden. Only the information for the points in black colour is 1498 

shown.  1499 

 1500 

 1501 

 1502 
 1503 

To show the data for the hidden points, click once on the names in the grey colour.  1504 

 1505 

 1506 

 1507 



 1508 
 1509 

In case that you cannot see any data on the chart of the data pane, this does not mean always that the 1510 

respective TSO does not publish information. It is possible that the data publication for the selected 1511 

indicators and point is not applicable.  1512 

 1513 

 1514 
 1515 

To verify whether an exemption has been configured by the TSO, please check the Transport data part. 1516 

 1517 

 1518 
 1519 

For more details on the Not Applicable functionality and the publication exemptions, please refer to point 1520 

7.4.2.3. Data values publication exemptions. 1521 

 1522 

 1523 

 1524 

 1525 

 1526 

 1527 

 1528 

 1529 

 1530 



 TIME PANEL 1531 

 1532 

 1533 

The time panel is for setting the validity period of the information in question, as well as for defining the 1534 

granularity of the data to be displayed and the time zone in which the time indicators are to be shown.  1535 

 1536 

 1537 
 DATA GRANULARITY CONFIGURATION 1538 

 1539 

The Time panel allows the TP user to choose between daily and hourly granularity of the displayed data. 1540 

The hourly data could be visualised if the respective TSO has an hourly balancing regime and publishes 1541 

data on an hourly basis. The TSOs with an hourly balancing regime are publishing information with both 1542 

hourly and daily granularity. 1543 

Switching between the hourly and daily publications is possible through the Daily data and Hourly data 1544 

buttons. The active mode is the blue one: 1545 

 1546 

     1547 
 1548 



 1549 
 1550 

Care should be taken when choosing hourly mode. You may want to first adjust the Date period selection 1551 

to a few days at most. By default, the TP displays data for a full month in daily mode - this means around 1552 

30 values per point and indicator, but in hourly mode it will be 24 times this amount - around 750 values, 1553 

and so - it can look like you were displaying daily data over the previous two years.  1554 

The TP can handle these volumes, but it will cause a delay in displaying the data. 1555 

 1556 

 CAPACITY AND INTERRUPTION DATA PERIODIZATION 1557 

    1558 

The TSOs shall published Capacity and Interruption data on the Transparency Platform for long term in 1559 

advance. The Time Panel has a tool that allows TP Users to select how to visualize this information - in 1560 

“Periodized” or “Compact” manner. 1561 

> Periodized manner - the values for Capacity or Interruption indicator(s) are displayed per gas day - 1562 

single value for every gas day. This view is very well suited to do day-by-day or hour-by-hour 1563 

comparisons of indicators, e.g. Physical flow versus Capacity. 1564 

> Compact manner - the equal values for Capacity or Interruption indicator(s) are displayed per time 1565 

period for which the figures do not vary. This view is recommended when looking at very large time 1566 

intervals (ten or twenty years), or if your goal is to spot the variations in value for Capacity or 1567 

Interruption data. 1568 

 1569 

 1570 

 1571 

 1572 

 1573 

Periodized manner of data visualization on the chart: 1574 



 1575 

 1576 
 1577 

Periodized manner of visualization of transport data: 1578 

 1579 

 1580 
 1581 

Compact manner of data visualization on the chart: 1582 

 1583 

 1584 
 1585 

Compact manner of visualization of transport data: 1586 

 1587 



 1588 
 1589 

 1590 
 1591 

The user selection for visualization of the Capacity and Interruption data in “Periodized” or “Compact” 1592 

manner is applied in the export result from the TP Export Tool.  1593 

If a TP user displays the indicators values in “Periodized” manner and after that run an export query, the 1594 

Capacity and Interruption data in the exported report will be presented in “Periodized” manner, as well. 1595 

 1596 
 1597 

If a TP user displays the indicators values in “Compact” manner and after that run an export query, the 1598 

Capacity and Interruption data will be presented in the exported report in “Compact” manner, 1599 

respectively. 1600 

 1601 
 1602 

 1603 
 1604 

Choosing the Periodization option will respectively limit the amount of data that you can download, as it 1605 

increases exponentially the quantity of the values returned by the Platform. This is particularly the case 1606 

for the Capacity and Interruption indicators - typically the Technical Capacity may not change or would 1607 

change rarely during an year, and so - in “Compact” mode you will get only one value, when in “Periodized” 1608 

mode the Platform will return 365 daily values or 8760 values on hourly basis.  1609 



For these reasons, the “Periodized” manner of visualization and export is best suited when looking at 1610 

specific IPs or for data for short time periods. The “Compact” option is more appropriate if your goal is to 1611 

get as much data as possible.  1612 

 1613 

 TIME ZONE SETTINGS 1614 

 1615 

The Time zone of the displayed information can be changed through a drop-down menu: 1616 

 1617 
 1618 

 1619 

 DEFINING THE PERIOD IN QUESTION 1620 

 1621 

The period for which the information is displayed can be defined through the Time panel - From Gas day 1622 

– To Gas day calendar functions: 1623 

 1624 
 1625 



 1626 
 1627 

The selected period through the calendar is shown on the horizontal axis of the graph and on the slide bar 1628 

below the graph chart area. 1629 

 1630 

 1631 
 1632 



 1633 
 1634 

The TP user can narrow the period previously defined through the calendar and zoom in the displayed 1635 

graph by using the slide bar.  1636 

 1637 

 1638 
 1639 

If you press and hold the primary mouse button on the narrowed slot, you can slide it over the predefined 1640 

through the calendar period. 1641 

 1642 

 1643 
 1644 

 1645 
 1646 

 1647 

 1648 

 1649 

 INDICATORS PANEL 1650 

 1651 

 1652 

 POINT INDICATORS 1653 

 1654 

The Indicators panel allows TP users to select the point parameters for which information will be displayed. 1655 

 1656 



 1657 
 1658 

Through the Indicators panel the users can activate or deactivate the data visualisation for 30 indicators 1659 

set in 3 groups: 1660 

 1661 

 OPERATIONAL/TRANSPORT INDICATORS 1662 

 1663 

 1664 
 1665 

 1666 

 1667 

 1668 

 1669 

 1670 

 1671 

 CAPACITY INDICATORS 1672 

 1673 



 1674 
 1675 

 1676 

 INTERRUPTION INDICATORS 1677 

 1678 

 1679 
 1680 

 1681 

 1682 



 1683 
 1684 

To display information about more indicators simultaneously, simply select them by clicking the white box 1685 

next to the parameter name. The box next to an indicator name become green when selected. 1686 

 1687 

 1688 
 1689 

 1690 
 1691 

It is possible to display data for all indicators at once by selecting/deselecting the 1692 

 box next to the title of the Indicators panel. 1693 

 1694 

To activate and display information for all TP indicators, press the box next to INDICATORS title of the 1695 

panel. 1696 



 1697 
 1698 

If you want to activate/deactivate the information for a particular indicator, just mark/unmark the box 1699 

next to the indicator name. 1700 

 1701 



 1702 
 1703 

The information about each indicator is displayed in a different colour on the graph chart.  1704 

The correspondence between the colour code and the indicator is shown below the Data panel where the 1705 

name(s) of the point(s), point direction(s) and indicator for which information is displayed are listed: 1706 

 1707 

 1708 
 1709 

 ZONE INDICATORS 1710 

 1711 

The indicators for which information could be displayed for the Balancing Zones defined on ENTSOG TP 1712 

are Physical flow, Allocation and Nomination/Renomination data. 1713 

 1714 

 1715 



 POINTS DATA PANEL TABS 1716 

 1717 

 1718 

 POINTS TAB 1719 

 1720 

In the Points tab, information about the selected point(s) and indicator(s) is presented in graphical way: 1721 

 1722 

 1723 
 1724 

The list of the points, including point directions and operator, as well as the indicator for which the data is 1725 

displayed on the graph, are listed in a legend below the data panel: 1726 

 1727 

 1728 
 1729 

 1730 

 TRANSPORT DATA TAB 1731 

 1732 

In the Transport data tab, the information about the selected point(s) and indicator(s) is presented in a 1733 

numerical way: 1734 

 1735 



 1736 
 1737 

 1738 

 1739 
 1740 

 1741 
 1742 

The information presented on Transport data panel can be sorted based on one or several parameters 1743 

simultaneously: 1744 

 1745 

 1746 
 1747 

The sorting could be done based on: 1748 

▪ Point name; 1749 

▪ Operator name; 1750 

▪ Point EIC; 1751 

▪ Point direction; 1752 

▪ Concerned period; 1753 

▪ Indicator; 1754 

▪ Value; 1755 

▪ Update date. 1756 

 1757 

To sort the data based on one parameter, simply press on the name of the parameter on the Parameter 1758 

bar. 1759 

 1760 

 1761 



In this example, the data is sorted based on its validity period: 1762 

 1763 

 1764 
 1765 

 1766 

In this example, the data is sorted based on the point name: 1767 

 1768 

 1769 
 1770 

 1771 

To sort the data based on two or several parameters simultaneously, press and hold the SHIFT key of the 1772 

keyboard and select the parameters for sorting. 1773 

In the following example, the data is sorted based on point name, point direction and validity period of 1774 

the data: 1775 

 1776 

 1777 
 1778 

 1779 



In the next example, the data is sorted based on point name, operator name and indicator: 1780 

 1781 

 1782 
 1783 

 1784 
 1785 

The information presented on the Transport data panel can be filtered based on one or several 1786 

parameters, by using the fields dedicated for this purpose. 1787 

 1788 

 1789 
 1790 

 1791 

 1792 

 1793 

 1794 

 1795 

 1796 

 1797 

 1798 

 1799 

 1800 

 1801 

 1802 

 1803 



 1804 
 1805 

Unfiltered information: 1806 

 1807 

 1808 
 1809 

 1810 

Information filtered based on the direction parameter – data is displayed only for the entry point direction: 1811 

 1812 

 1813 
 1814 

 1815 

 1816 

 1817 

 1818 

 1819 

 1820 

 1821 

 STATUS OF THE PUBLISHED INFORMATION 1822 



 1823 

In the Transport data tab the status of the published information could be indicated.  1824 

The status definition is available only for the following indicators: 1825 

 1826 

▪ Physical flow; 1827 

▪ Allocation; 1828 

▪ GCV; 1829 

▪ WI. 1830 

 1831 

The status of the data for these parameters can be defined by the TSO that is publishing the information 1832 

as: 1833 

▪ Provisional – denoted by orange ball:  1834 

 1835 

 1836 
 1837 

 1838 

▪ Confirmed – denoted by green ball:  1839 

 1840 

 1841 
 1842 

 1843 

 1844 

 1845 

 DATA VALUES 1846 



 1847 

The value and the units of an indicator for a particular point (direction) and user defined period are 1848 

displayed in the Value section of the Transport data tab: 1849 

 1850 

 1851 
 1852 

 1853 

 DATA VALUES PUBLICATION EXCEPTIONS 1854 

 1855 

There are exceptional cases when an operator cannot provide value(s) of a certain indicator for a particular 1856 

point, point direction and time period. These cases could be for regulatory reasons. 1857 

 1858 

For example: 1859 

▪ An import only point is defined as bidirectional. In the contraflow exit direction the operator does 1860 

not offer capacity. In this case it cannot publish any information for the indicators for the contraflow 1861 

direction. 1862 

▪ A point is defined as bidirectional. The flow is going mainly in one of the point directions. For the 1863 

opposite point direction the operator offers backhaul capacity. For this point direction the operator 1864 

cannot publish information about physical flow. 1865 

 1866 

For such cases ENSTOG TP provides functionality for setting the “N/A” (Not applicable) notation on the 1867 

place of the numerical value. In addition the operators must add a remark providing information for the 1868 

reason of not-applicability of the data publication. 1869 

 1870 

For the cases when the operator does not possess information that shall be published, the TP offers 1871 

possibility for setting a “-“ (Minus sign). 1872 

Such an instance could be the situation when an operator did not receive re-nomination(s) from the 1873 

shippers. Since in this case, the publication of zero value could be misleading, because in normal 1874 

circumstances a shipper could submit a re-nomination equal to 0 kWh/d or 0 kWh/h, the operator can 1875 

publish “-“ (Minus sign). 1876 

 1877 

The purpose of the Minus sign and N/A functionality is: 1878 

▪ To allow the operators to fulfil their publication obligations in case of regulatory exceptions or 1879 

absence of data; 1880 

▪ To facilitate TP users to comprehend the information provided.  1881 

 1882 



 1883 
 1884 

Example for N/A publications: 1885 

 1886 

 1887 
 1888 

 1889 
 1890 

Example for Minus sign publications: 1891 

 1892 

 1893 
 1894 

 1895 

 1896 

 1897 

 1898 

 1899 

 1900 



 1901 
 1902 

With regards to the aforementioned, the Blank cell of a Transport data value field means – Data not 1903 

published by the operator.  1904 

 1905 

 1906 
 1907 

 1908 

 CMP DATA TAB 1909 

 1910 

The CMP data tab shows information about the Unsuccessful request for firm capacity and/or capacity 1911 

allocated as a result of CMP procedure(s) application. 1912 

This section is dedicated for data publication in line with the requirements of Regulation (EC) N715/2009, 1913 

Annex I, point 3, 3.3(1), (h), (i), (j), (k). 1914 

 1915 

 1916 
 1917 

 1918 

 1919 

 1920 

 1921 

 1922 

 1923 

 1924 

 1925 

 1926 

 1927 



 CMP UNSUCCESSFUL REQUESTS 1928 

 1929 

CMP Unsuccessful Requests section shows the occurrence(s) (if any) of unsuccessful, legally valid requests 1930 

for firm capacity products with a duration of one month or longer, including the number and volume of 1931 

the unsuccessful requests, by specifying concerned point, period, the requested, allocated and unsatisfied 1932 

capacity. 1933 

 1934 

 1935 
In case of an absence of occurrences of unsuccessful requests for firm capacity products with a duration 1936 

of one month or longer, the operators publish remarks containing explanation of the case. The explanation 1937 

is provided through sentences harmonised among the operators. 1938 

 1939 

 1940 
 1941 

 CMP AUCTION RESULTS 1942 

 1943 

The CMP Auction Results section shows where and when firm capacity products with a duration of one 1944 

month or longer have cleared at prices higher than the reserve price, by specifying concerned point, 1945 

period, auction cleared and reserved price. 1946 

 1947 

 1948 



In case of absence of occurrences of auctions when firm capacity products with a duration of one month 1949 

or longer have cleared at prices higher than the reserve price, the operators publish remarks containing 1950 

an explanation of the case. The explanation is provided through sentences harmonised among the 1951 

operators. 1952 

 1953 

 1954 
 1955 

 CMP UNAVAILABLE FIRM CAPACITY 1956 

 1957 

The CMP Unavailable Firm Capacity section shows where and when no firm capacity product with a 1958 

duration of one month or longer has been offered in the regular allocation process, by specifying 1959 

concerned point, period, and allocation process. 1960 

 1961 

 1962 
 1963 

In case of an absence of occurrences when no firm capacity product with a duration of one month or longer 1964 

has been offered in the regular allocation process, the operators publish remark containing explanation of 1965 

the case. The explanation is provided through sentences harmonised among the operators. 1966 

 1967 

 1968 
 1969 

 CMP CAPACITIES MADE AVAILABLE 1970 



 1971 

The CMP Capacities Made Available section shows total capacity made available through the application 1972 

of the congestion-management procedures: Oversubscription and Buy-Back, Firm day-ahead use-it-or-1973 

lose-it, Surrender of contracted capacity, Long-term use-it-or-lose-it, by specifying concerned point, period 1974 

and allocated volume per applied congestion-management procedure. 1975 

 1976 
 1977 

In case of an absence of occurrences when capacity was made available through the application of the 1978 

congestion-management procedures, the operators publish remarks containing an explanation of the 1979 

case. The explanation is provided through sentences harmonised among the operators. 1980 

 1981 

 1982 
 1983 

 1984 

 1985 

 1986 

 1987 

 1988 

 1989 

 1990 

 TARIFF DATA TAB 1991 



 1992 

The updated Tariff data section has two sections:  1993 

 1994 

 1995 
 1996 

> Tariff data: this tab shows information about the various tariff types and components related to the 1997 

tariffs, the actual tariff values referred to as applicable tariffs, the various units related to the tariffs 1998 

for the selected point and period. 1999 

 2000 

The table contains information about binding reserve prices including multipliers, seasonal factors and 2001 

interruptible discounts and flow-based charges (if applicable) for standard capacity products (firm and 2002 

interruptible), for all Interconnection Points by default.  2003 

 2004 

ENTSOG and the TSOs have developed two important methodologies to ensure user-friendliness and 2005 

comparability of the tariff data:  2006 

▪ The validity period approach: “A validity period:  2007 

○ (1) is given for each product type;  2008 

○ (2) is defined as the longest duration of a given product type where the tariff for such product 2009 

type is the same; and  2010 

○ (3) must be no longer than a tariff period. “ 2011 

 2012 

The validity period approach reduces the number of rows in the standardised table significantly, as 2013 

the product start- and end date is implicitly indicated by showing the product type. For example, 2014 

for the validity approach only one line is displayed in the standardised table in the case of the same 2015 

prices for daily products, instead of 365 lines.  2016 



 2017 

▪ The common unit: As an additional piece of information for harmonisation purposes, the 2018 

standardised table contains the applicable tariff in what the TSOs call “the common unit”. In praxis this 2019 

means that every TSO converts its tariffs into a common unit by recalculating the tariff from its own 2020 

unit into [local currency]/(kwh/h)/d for Yearly, Quarterly, Monthly, Daily and [local 2021 

currency]/(kwh/h)/h for WithinDay. In other words, you can find comparable data for all products no 2022 

matter which unit is applied in the “Applicable tariffs”.  2023 

 2024 

When using the tariff data table, it’s important to notice the plus-signs which will expand additional 2025 

columns with more information.   2026 

 2027 

> Simulation: ‘Simulation’ contains the simulation of all the costs for flowing 1 GWh/day/year for each 2028 

IP per product type and tariff period.   2029 

 2030 

 2031 

To improve transparency, it was agreed to calculate the simulation costs not only for yearly products, 2032 

but also for quarterly, monthly and daily products. ENTSOG’s solution also allows TSOs to provide 2033 

information for within-day products on a voluntary basis. The calculation of the simulation costs 2034 

includes the capacity charges, flow-based charges and all kind of charges which are applied at the 2035 

respective IP – e. g. metering charges, gas quality conversion charges, biogas charges.  Those elements, 2036 

which are part of the calculation will be added in the remark for the respective field of the simulation 2037 

cost value. The calculation of the simulation cost values is made under the assumption that the load 2038 

factor is 1, meaning that the gas flow is constant over the year – 1GWh every day of the year. 2039 

 2040 

When using the simulation table, it’s important to notice the plus-signs which will expand additional 2041 

columns with more information.   2042 

 2043 

For further elaboration on the contents of the tariff data section, please refer to the Implementation 2044 

Document Chapter VIII and Annex S, developed by ENTSOG’s Tariff Working Group.  2045 

 2046 

APIs for the Tariff data and Simulations will be provided during Q1 2018.  Please note that the tariffs 2047 

published pm a voluntary basis before December 2017 are available via a special report “Tariff publ. before 2048 

TAR NC” in the Export Wizard section.  2049 

 2050 

 POINT INFORMATION TAB 2051 

https://www.entsog.eu/public/uploads/files/publications/Tariffs/2017/TAR1000_170928_2nd%20Implementation%20Document_High-Res.pdf
https://www.entsog.eu/public/uploads/files/publications/Tariffs/2017/TAR1000_170928_2nd%20Implementation%20Document_High-Res.pdf


 2052 

The Point information tab shows information about the point name, point identifier, CAM/CMP relevance, 2053 

validity period, offered type of contracts per point, related booking platform with direct link, maximum 2054 

value of the GCV and conversion factor used by the respective TSO for converting the information from 2055 

volume to energy units. 2056 

 2057 

 2058 

 2059 

 2060 
 2061 

 2062 
 2063 

The information presented on CMP data, Tariff data and Point information panels can be sorted based on 2064 

one or several parameters simultaneously. To sort the data simply press on the name of the selected 2065 

parameter(s) on the Parameter bar. For details, please refer to the explanation on how to sort data on 2066 

Transport data panel. 2067 

The information presented on CMP data, Tariff data and Point information panels can be filtered based on 2068 

one or several parameters by using the fields dedicated for this purpose. 2069 

For details, please refer to the explanation on how to filter data on Transport data panel. 2070 

 2071 

 2072 

 EXPORT WIZARD TAB 2073 

 2074 

The Export Wizard Tab leads the users to the TP Export Tool. The TP Export Tool allows manual export of 2075 

points and zones information.  2076 

The functionalities and the points information export options are explained in the next points: from 7.4.6.1 2077 

to 7.4.6.3. 2078 

The functionalities and the zones information export options are explained in point 7.5.4 2079 

 2080 



 EXPORT WIZARD OPTIONS 2081 

 2082 

Through the Export wizard the TP users can export information in XLSX, CSV and XML format.  2083 

Currently, the TP Export Tool is able to export more than 30 000 rows of information in CSV format, which 2084 

results for example in bulk of daily data for all TP points and directions for one indicator for 37 days, equal 2085 

to a file with size around 9 MB. The point information manual export in XLSX format returns maximum 2086 

around 10 000 rows of information equal to daily data for all TP points and directions for one indicator for 2087 

13 days. However, the actual quantity of data which could be obtained through the TP Export tool depends 2088 

as well on the TP user’s internet connection parameters as - bandwidth and speed. 2089 

 2090 

 2091 
As general recommendation we would suggest the CSV data format to be used for bigger export queries. 2092 

 2093 

TP users can choose the data to be exported by selecting the TSO in interest, point direction, point type 2094 

(only CAM-Relevant or All points), data type (Transport data, CMP information, Point information). 2095 

 2096 

 2097 
 2098 

 2099 
 2100 



The number of the points for which data is exported through the TP Export Tool depends on the 2101 

completeness of the data published by the TSOs. If for particular period, point and indicator a TSO has 2102 

missing data or does not publish information (for any reason), the particular point is not included the 2103 

respective queries (export file) for the selected period and indicator(s). 2104 

 2105 

 2106 
 2107 

You can select whether to export information in daily or hourly mode, by clicking on the respective button:  2108 

 2109 
Be aware that the hourly publications are not mandatory for all TSOs and indicators. In case that no data 2110 

is published for particular point, indicator and period, in hourly or daily mode, the TP Export Tool will not 2111 

return an export result.  2112 



 2113 
 2114 

 2115 

 2116 

 2117 

 2118 

 2119 

 2120 

 2121 

 2122 

 2123 

 2124 



 2125 
 2126 

Example on how to use the options of the Export wizard: 2127 

 2128 

The TSO whose point information is needed can be selected from a drop-down menu: 2129 

 2130 

 2131 
 2132 

The Type of exported information can be selected through the Source drop-down menu. 2133 

The Transport data includes nominations, re-nominations, physical flow, allocations, capacity, 2134 

interruptions and gas quality data. 2135 

The CMP data includes information about the unsuccessful requests for firm capacity, the auction results 2136 

concluded with auction premium and allocated capacity through the application of particular CMP 2137 

procedure(s) during the selected period.  2138 

In addition, the TP users can obtain general information about the selected points like – point EIC, validity 2139 

period, CAM relevance, possible contract types depending on the time period and etc. 2140 

 2141 



 2142 

 2143 

 2144 
 2145 

 2146 

 2147 

 2148 



 2149 

 2150 

 2151 

 2152 

 2153 

 2154 

 2155 

 2156 

 2157 

 2158 

 2159 

 2160 

 2161 

 2162 

 2163 

The information could be exported in XLSX, CSV and XML format. 2164 

 2165 

 2166 
 2167 

 2168 



 2169 

 2170 

 2171 

 2172 

 2173 

 2174 

 2175 

 2176 

 2177 

 2178 

 2179 

 2180 

 2181 

 2182 

 2183 

For the CSV export, the TP users could choose either a comma or semi-colon delimiter. 2184 

 2185 



 2186 
 2187 

 2188 
 2189 

How to export information for the physical flow through all CAM-Relevant points in Europe for the period 2190 

1 July – 1 August 2015? 2191 

 2192 

In order to export the information in interest from the TP it is important not only to select the point type, 2193 

operator, direction and data source, but also to define the period and indicators for which the data is 2194 

needed. 2195 

The required period and indicators shall be selected through the respective Time/Calendar and Indicators 2196 

panels. 2197 



 2198 
 2199 

 2200 
 2201 

How to export information about the unsuccessful requests for capacity received by a TSO for its exit 2202 

points during the period 1 July – 1 August 2015? 2203 

 2204 

For exporting CMP information, it is required to select the appropriate data source, point type and 2205 

direction, TSO, time period of interest and export format. An example is shown below: 2206 

 2207 



 EXPORT STATES 2208 

 2209 

The Export state is shown in the Export Infos section of the Export Wizard: 2210 

 2211 

 2212 
 2213 

The Export Infos section provides details on: 2214 

> Elapsed time: The time elapsed for the generation of the requested report;  2215 

> Export state: Shows the status of the export query: 2216 

▪ - : The user has not clicked on Export button; 2217 

▪ Querying: The user has clicked on Export button, the TP is querying its database to return the 2218 

requested data; 2219 

▪ Successful: The TP has finished its query successfully; 2220 

▪ Cancelled Query: The user has stopped its query while it was in progress; 2221 

▪ Time-Out: The user has tried to download too much data, the TP has blocked this request; 2222 

▪ No data: The query of the user doesn’t return any data from the TP database. 2223 

> Operation status: Denoted through the text color: 2224 

▪ Green: Successful Query; 2225 

▪ Red: Time-Out; 2226 

▪ Black: All other export states. 2227 

> Exported data: The export file containing an organized view of the API results in one of the available 2228 

file formats. 2229 



 2230 

 2231 

Example of “Successful” Query: 2232 

> Export Button is clickable; 2233 

> Elapsed Time displays the total elapsed time in seconds and milliseconds; 2234 

> Export state: Successful; 2235 

> Elapsed Time and Export state appear in bold green; 2236 

> The browser prompts the user to download the resulted document. 2237 

 2238 

 2239 
 2240 

 2241 

 2242 
 2243 

Example of “Querying” State: 2244 

> Export button is blocked; 2245 

> Elapsed Time displays a running clock; 2246 

> Elapsed Time shows time in seconds and milliseconds; 2247 



> Export state: Querying; 2248 

> Elapsed Time and Export state appear in black; 2249 

> Export button caption displays alternation dots to show that an operation is being performed; 2250 

> Stop red square button is displayed to the right of the export button; 2251 

> Clicking on the Stop button cancels the query. 2252 

 2253 

 2254 
 2255 

 2256 

 2257 
 2258 

Example of “Cancelled Query” State: 2259 

> Export Wizard transitions into this state when the query is cancelled; 2260 

> Stop Button is hidden; 2261 

> Elapsed Time displays the total elapsed time in seconds and milliseconds until cancellation; 2262 

> Export state: Cancelled; 2263 



> Elapsed Time and Export state appear in black; 2264 

> The browser does not prompts the user to download anything. 2265 

 2266 

 2267 
 2268 

 2269 

 2270 
 2271 

Example of “Time-Out” State: 2272 

> Export Wizard transitions into this state when the query cannot be completed because of Time-Out. 2273 

The TP sets a maximum time of 60 seconds for a query to produce a result, in order to limit the stress 2274 

on the TP resources. 2275 

> Export Button is clickable; 2276 

> Stop Button is hidden; 2277 

> Elapsed Time displays the total elapsed time in seconds and milliseconds until the Time-Out; 2278 

> Export state: Time-Out; 2279 



> Elapsed Time and Export state appear in bold red; 2280 

> Next to the notice “Time-Out”, a little  symbol appears, with a tooltip saying "Too much data 2281 

requested. Please reduce the data volume by adjusting your parameters (e.g. less points, smaller time 2282 

frame)." 2283 

 2284 

 2285 
 2286 

 2287 

 2288 
 2289 

Example of “Idle” State: 2290 

> The Idle State is the initial default state of the Export Wizard; 2291 

> Export Button is clickable; 2292 

> Elapsed time shows a "-" sign; 2293 



> Export state shows a "-" sign; 2294 

> Stop Button is hidden. 2295 

 2296 

 2297 
 2298 

 2299 

 2300 
 2301 

Example of “No Data” State: 2302 

> Export Wizard transitions into this state when the query is successful but returns no results; 2303 

> Export Button is clickable; 2304 

> Elapsed Time displays the total elapsed time in seconds and milliseconds; 2305 

> Export State: No Data; 2306 

> Elapsed Time and Export state appear in black; 2307 

> Stop Button is hidden; 2308 



> The browser does not prompt the user to download or open a document, as there are no data to be 2309 

downloaded. 2310 

 2311 

 2312 
 2313 

 2314 

 EXPORT WIZARD – EXPLANATION OF FIELDS 2315 

 2316 

Below you can find description of the information manually exportable through TP Export Wizard. Each 2317 

table contains explanation of the meaning of the column titles of the export files. 2318 

The provided samples in the “Possible values/Example” column should not be treated as an instance of a 2319 

real export file. The samples shall be examined on field by field basis as illustration of the possible export 2320 

values. 2321 

 2322 

 TRANSPORT DATA EXPORT FIELDS 2323 

 2324 

TRANSPORT DATA EXPORT 
FIELDS 

MEANING OF THE FIELD TITLE POSSIBLE VALUES / EXAMPLE 



id Technical identifier which is a 
unique fingerprint of the data item. 

1Physical Flowday2016-02-
182016-02-19DE-TSO-0010ITP-
00019entrykWh/d 

dataSet Datasets represent groups of 
similar data items.  
Possible values: 
1: Transport Data indicators 
2: CMP Unsuccessful Requests 
3: CMP Auctions 
4: CMP Unavailable 
5: Detailed Interruption data 
The value of the field shows the 
type of exported data set. 

1 

indicator Name of the indicator Physical Flow 

periodType Period Type (Day or Hour) - 
represents the granularity of the 
data. 

Day 

periodFrom Start of the period for which the 
information is valid (start of the gas 
day or gas hour).  
The hour is shown in the time zone 
selected by the TP user. 

2016-02-18 06:00 

periodTo End of the period for which the 
information is valid (end of the gas 
day or gas hour). 
The hour is shown in the time zone 
selected by the TP user. 

2016-02-19 06:00 

operatorKey Unique ID of the TSO in the TP 
Database.  
Contrary to the EIC codes, this ID 
can never change. 

DE-TSO-0010 

tsoEicCode EIC code of the TSO. The EIC code 
of the TSO may change over time. 

21X-DE-A-A0A0A-A 

operatorLabel TSO name Bayernets 

pointKey Unique ID of the point in the TP 
Database.  
Contrary to the EIC codes, this ID 
can never change. 

ITP-00007 

pointLabel Name of the point for which 
information is exported. 

Überackern SUDAL (AT) / 
Überackern 2 (DE) 

tsoItemIdentifier Code used by the TSO for data 
publication for a point.  
Since October 2015, only EIC codes 
are used as point identifiers on 
ENTSOG TP.  

21Z0000000001240 

directionKey Flow direction (Entry or Exit) Entry 



unit Units in which the indicator value is 
presented (kWh/d, kWh/h, 
kWh/m³, etc.) 

kWh/d 

itemRemarks Item specific optional remark, 
which can be visualized in the 
exports. 

Remark text could appear here if 
published by the TSO. 

generalRemarks Generic optional remark over a 
group of data items published by 
the TSO at the same time. 

General remark information for 
the group of data (for example 
for all Nominations publications) 
could appear here if published by 
the TSO. 

value Value of the indicator 21742397 

lastUpdateDateTime The date of the upload of the 
information on the TP.  
For Capacity and Interruption 
indicators - the date at which the 
last change in value was observed. 

2016-02-19 10:10 

isUnlimited The field is valid only for 
Interruptible capacity.  
In case that the Interruptible 
capacity offered by a TSO is 
unlimited, the value of the field is 
set to TRUE and the TP visualize the 
symbol "∞".  
The value of the field is FALSE if the 
Interruptible capacity offered by 
the TSO is not unlimited. 
The field is empty if the 
information is exported for 
indicator different than 
Interruptible capacity. 

 

flowStatus The status of the information 
(Provisional or Confirmed), 
displayed only for Physical flow, 
Allocation, GCV and WI values. 

Confirmed 
 

interruptionType The type of interruption (Planned, 
Unplanned, Actual), valid only for 
Interruption data. 
The field is empty if the 
information is exported for 
parameters different than 
Interruption indicators. 

 



restorationInformation The field is valid only for the 
Interruption data.  
It may contain free text 
information provided by the TSO 
about the expected restoration 
from an interruption event. The 
information is not visualized on the 
Platform. 
If submitted by the TSO, it is 
available only for export.  

 

capacityType Type of capacity (Firm or 
Interruptible), valid only for 
Capacity and Interruption data. 
The field is empty if the 
information is exported for 
parameters different than Capacity 
or Interruption indicators. 

 

capacityBookingStatus Booking status of the capacity 
(Booked, Available, Total), valid 
only for Capacity or Interruption 
data. The field is empty if the 
information is exported for 
parameters different than Capacity 
or Interruption indicators. 

 

isCamRelevant TRUE if the point is CAM-relevant. 
FALSE if the point is NON-CAM-
relevant. 

TRUE 

isNA The field shows whether “Not 
Applicable” functionality for data 
publication was activated by the 
TSO for the particular 
point/direction/indicator/period.  
If the value of the field is TRUE, this 
means that a “Not applicable” 
functionality is activated and 
instead of displaying a value on the 
platform “N/A” is published.  
If the field is blank, this means that 
there are no exceptions and the 
value of the indicator shall be 
presented.  

 

originalPeriodFrom Technical field represents the first 
day on which the “Not applicable” 
solution has been activated. The 
field is only filled, if “isNA” is set to 
TRUE. 

 

 2325 

 POINTS INFORMATION EXPORT FIELDS 2326 



 2327 

POINTS INFORMATION  
EXPORT FIELDS 

MEANING OF THE FIELD TITLE POSSIBLE VALUES / EXAMPLE 

pointKey Unique ID of the point in the TP 
Database. 
Contrary to the EIC codes, this ID 
can never change. 

ITP-00056 

pointLabel Name of the point Oberkappel (GRTgaz D) 

operatorKey Unique ID of the TSO in the TP 
Database.  
Contrary to the EIC codes, this ID 
can never change. 

DE-TSO-0004 

operatorLabel TSO name GRTgaz Deutschland 

directionKey Flow direction (Entry or Exit) entry 

validFrom Point validity start date, as defined 
by ENTSOG TP administrator. 
 
The indicator is not relevant for 
this dataset. 

Example not applicable. 

validTo Point validity end date, as defined 
by ENTSOG TP administrator. 
 
The indicator is not relevant for 
this dataset. 

Example not applicable. 

hasData TRUE in case that the TSO has 
configured its IT system to publish 
data at this point. 
Please note that it just means that 
the TSO has the technical ability to 
provide data at the point. It may 
happen that data may still be 
missing temporarily for certain 
days, in case of punctual data 
communication errors. 
When FALSE or empty, it means 
that the TSO has not configured its 
IT system to upload data for this 
point, i.e. the point is not relevant. 

TRUE 

isVirtualizedCommercially TRUE in case that the point is 
commercially virtualized. In this 
case, the data is published for the 
virtual point.  
FALSE if the point is not virtualized 
commercially. 

FALSE 



virtualizedCommerciallySince The start date of the commercial 
virtualization of the point after 
which the information is published 
for the virtual point. 
The field is empty if the value of 
the “isVirtualizedCommercially” is 
FALSE. 

 

isVirtualizedOperationally TRUE in case that the point is 
operationally virtualized. In this 
case the data is published for the 
virtual point.  
FALSE if the point is not virtualized 
operationally. 

FALSE 

virtualizedOperationallySince The start date of the operational 
virtualization of the point after 
which the information is published 
for the virtual point. 
The field is empty if the value of 
the “isVirtualizedOperationally” is 
FALSE. 

 

isPipeInPipe TRUE if a pipe-in-pipe situation is 
valid for the point, otherwise the 
value of the field is FALSE. 

TRUE 

pipeInPipeWithTsoKey The TP ID of the other TSO 
participating in the pipe-in-pipe 
situation and the TP ID of the point. 
The filed is depended of the value 
of the fields “isPipeInPipe”. 
If the value of the fields 
“isPipeInPipe” is TRUE, the field 
“pipeInPipeWithTsoKey” contain 
the TP ID of the respective TSO and 
the TP ID of the point.  

DE-TSO-0009/ITP-00006 

pipeInPipeWithTsoLabel The name of the other TSO 
participating in the pipe-in-pipe 
situation and the name of the 
point. 
The filed content is depended of 
the value of the fields 
“isPipeInPipe”. 
If the value of the fields 
“isPipeInPipe” is TRUE, the field 
“pipeInPipeWithTsoLabel” contain 
the name of the respective TSO and 
the name of the point. 

Open Grid Europe/Oberkappel 
(OGE) 

isDoubleReporting TRUE if the TSO is publishing the 
data at the point on behalf of 
another TSO, for legal reasons. 

FALSE 



doubleReportingWithTsoKey The TP ID of the TSO to which the 
point actually belongs and the TP 
ID of the point. 
The filed content is depended of 
the value of the fields 
“isDoubleReporting”. 
If the value of the fields 
“isDoubleReporting” is TRUE, the 
field “doubleReportingWithTsoKey” 
contain the TP ID of the respective 
TSO to which the point belongs and 
the TP ID of the point. 

 

doubleReportingWithTsoLabe
l 

The name of the TSO to which the 
point actually belongs and the 
name of the point. 
The filed content is depended of 
the value of the fields 
“isDoubleReporting”. 
The filed is depended of the value 
of the fields “isDoubleReporting”. 
If the value of the fields 
“isDoubleReporting” is TRUE, the 
field 
“doubleReportingWithTsoLabel” 
contain the name of the respective 
TSO to which the point belongs and 
the name of the point. 

 

tsoItemIdentifier Code used by the TSO for data 
publication for a point.  
Since October 2015, only EIC codes 
are used as point identifiers on 
ENTSOG TP.  

21Z000000000161V 

tpTsoItemLabel The name of the point, as defined 
by the TSO 

Oberkappel 

tpTsoValidFrom Point validity start date, as defined 
by the TSO. 

2005-10-01 00:00 

tpTsoValidTo Point validity end date, as defined 
by the TSO. 

2099-12-3 00:00 

tpTsoRemarks Optional remark about the point 
defined by the TSO. 

Remark text could appear here if 
published by the TSO. 

tpTsoConversionFactor Conversion factor to be used for 
conversion of the capacity value 
from volume to energy units, in 
case that the data is submitted by 
the TSO in volume. The value is 
equal to "1" in case that the 
capacity value is submitted by the 

1 



TSO directly in energy units and no 
conversion is needed. 

tpRmkGridConversionFactorC
apacityDefault 

Optional remarks provided by the 
TSO that can eventually provide 
more information about the 
conversion factor used. 

Remark text could appear here if 
published by the TSO. 

tpTsoGCVMin Default value of the GCV defined by 
the TSO for conversion purposes. 

11.1 

tpTsoGCVMax Maximum value of the GCV defined 
by the TSO for conversion purposes 
(optional). 

 

tpTsoGCVRemarks Optional remark about the value of 
the GCV published by the TSO for 
conversion purposes.  

Remark text could appear here if 
published by the TSO. 

tpTsoGCVUnit Unit for the GCV data kWh/m³ 

tpTsoEntryExitType Type of the point according to the 
TSO (Entry, Exit, or Entry-Exit) 
 
The indicator is not relevant for 
this dataset. 

Example not applicable. 

multiAnnualContractsIsAvaila
ble 

TRUE in case that the TSO offers 
Multi-annual contracts at the 
particular point.  
FASLE if Multi-annual contracts are 
not offered. 

FALSE 

multiAnnualContractsRemark
s 

Optional remark about the Multi-
annual contracts published by the 
TSO. 

Remark text could appear here if 
published by the TSO, for 
example: “Contracts shall start at 
the 1st day of the month”. 

annualContractsIsAvailable TRUE in case that the TSO offers 
Annual contracts at the particular 
point.  
FASLE if Annual contracts are not 
offered. 

TRUE 

annualContractsRemarks Optional remark about the Annual 
contracts published by the TSO. 

Remark text could appear here if 
published by the TSO, for 
example: “Contracts shall start at 
the 1st day of the month”. 



halfAnnualContractsIsAvailabl
e 

TRUE in case that the TSO offers 
Half-annual contracts at the 
particular point.  
FASLE if Half-annual contracts are 
not offered. 

FALSE 

halfAnnualContractsRemarks Optional remark about the Half-
annual contracts published by the 
TSO. 

Remark text could appear here if 
published by the TSO, for 
example: “Contracts shall start at 
the 1st day of the month”. 

quarterlyContractsIsAvailable TRUE in case that the TSO offers 
Quarterly contracts at the 
particular point.  
FASLE if Quarterly contracts are not 
offered. 

TRUE 

quarterlyContractsRemarks Optional remark about the 
Quarterly contracts published by 
the TSO. 

Remark text could appear here if 
published by the TSO. 

monthlyContractsIsAvailable TRUE in case that the TSO offers 
Monthly contracts at the particular 
point.  
FASLE if Monthly contracts are not 
offered. 

TRUE 

monthlyContractsRemarks Optional remark about the Monthly 
contracts published by the TSO. 

Remark text could appear here if 
published by the TSO, for 
example: “Contracts shall start at 
the 1st day of the month”. 

dailyContractsIsAvailable TRUE in case that the TSO offers 
Daily contracts at the particular 
point. FASLE if Daily contracts are 
not offered. 

FALSE 

dailyContractsRemarks Optional remark about the Daily 
contracts published by the TSO. 

Remark text could appear here if 
published by the TSO. 

dayAheadContractsIsAvailabl
e 

TRUE in case that the TSO offers 
Day-ahead contracts at the 
particular point.  
FASLE if Day-ahead contracts are 
not offered. 

TRUE 

dayAheadContractsRemarks Optional remark about the Day-
ahead contracts published by the 
TSO. 

Remark text could appear here if 
published by the TSO. 

availableContractsRemarks Optional remark about the 
available contracts offered by the 
TSO at the particular point. 

Remark text could appear here if 
published by the TSO. 



sentenceCMPUnsuccessful In case of an absence of 
unsuccessful requests for firm 
capacity products with duration of 
one month or longer, the TSOs 
publish remark containing 
explanation of the case. The 
explanation is provided through 
sentences harmonized among the 
TSOs. 

Currently there are no requests 
for firm capacity products on this 
point with a duration of one 
month or longer that weren't 
successfully fulfilled. 

sentenceCMPUnavailable In case of an absence of 
occurrences when no firm capacity 
product with a duration of one 
month or longer has been offered 
in the regular allocation process, 
the TSOs publish remark containing 
explanation of the case. The 
explanation is provided through 
sentences harmonized among the 
TSOs. 

Currently firm products with a 
duration of one month or longer 
are offered on this point in the 
regular allocation process. 

sentenceCMPAuction In case of absence of occurrences 
of auctions when firm capacity 
products with a duration of one 
month or longer have cleared at 
prices higher than the reserve 
price, the TSOs publish remark 
containing an explanation of the 
case. The explanation is provided 
through sentences harmonized 
among the TSOs. 

Currently there are no firm 
capacity products on this point 
with a duration of one month or 
longer auctioned having cleared 
with an auction premium. 

sentenceCMPMadeAvailable In case of an absence of 
occurrences when capacity was 
made available through the 
application of the congestion-
management procedures, the TSOs 
publish remark containing an 
explanation of the case. The 
explanation is provided through 
sentences harmonized among the 
TSOs. 

Currently no capacity has been 
made available on this point 
through the application of the 
congestion-management 
procedures. 

lastUpdateDateTime The date at which the information 
was last updated by the TP. 

2016-04-18 11:04 

isInvalid Technical element used to denote 
an objects/information which is not 
valid anymore (e.g. point which has 
been terminated). TRUE is the 
object is not valid. FALSE if the 
object is valid. 

FALSE 



isCAMRelevant 1 if the point is CAM-relevant. 
Blank if the point is not CAM-
relevant. 

1 

isCMPRelevant 1 if the point is CMP-relevant. 
Blank if the point is not CMP-
relevant. 

1 

bookingPlatformKey Short name for the Booking 
Platform where capacity can be 
booked for the point 

PRISMA 

bookingPlatformLabel Long name for the Booking 
Platform where capacity can be 
booked for the point 

PRISMA 

bookingPlatformURL Link to the Booking Platform where 
capacity can be booked for the 
point 

https://platform.prisma-
capacity.eu/ 

id Technical identifier which is a 
unique fingerprint of the data item. 

5DE-TSO-0004ITP-00056entry 

dataSet Datasets represent groups of 
similar data items. Possible values: 
1: Operators 
2: Points 
3: Balancing Zones 
4: Interconnections 
5: Operator Point Directions 
6: Aggregate Interconnections 
The value of the field shows the 
type of exported data set. 
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ZONES INFORMATION 
EXPORT FIELDS 

MEANING OF THE FIELD TITLE POSSIBLE VALUES / EXAMPLE 

id Technical identifier which is a 
unique fingerprint of the data item. 

1AggregatesDEDE-GASPOOL-DE-
TSO-0005entryProduction2016-
02-18T00:00:00+00:002016-02-
19T00:00:00+00:00Physical Flow 

dataSet Datasets represent groups of 
similar data items.  
Possible value for the Zones 
information export: 
1: Aggregated Data at Balancing 
Level. 

1 

dataSetLabel Datasets represent groups of 
similar data items.  
Aggregates: Aggregated Data at 
Balancing Level. 

Aggregates 



The value of the field shows the 
type of exported data set. 

indicator Name of the indicator. 
Possible values: 
- Physical flow; 
- Nomination/Re-nomination; 
- Allocation. 

Physical Flow 

periodType Period Type (Day or Hour) - 
presents the granularity of the 
data. 

Day 

periodFrom Start of the period for which the 
information is valid (start of the gas 
day or gas hour).  
The hour is shown in the time zone 
selected by the TP user. 

2016-02-18 06:00 

periodTo End of the period for which the 
information is valid (end of the gas 
day or gas hour). 
The hour is shown in the time zone 
selected by the TP user. 

2016-02-19 06:00 

countryKey Country code of the name of the 
country to which the balancing 
zone belongs. 

DE 

countryLabel Name of the country to which the 
balancing zone belongs. 

Germany 

bzKey Unique ID of the balancing zone in 
the TP Database. 

DE-GASPOOL- 

bzShort Abbreviation/short name of the 
balancing zone. 

GASPOOL 

bzLong Full name of the balancing zone GASPOOL Balancing Zone 

operatorKey Unique ID of the TSO in the TP 
Database.  
Contrary to the EIC codes, this ID 
can never change. 

DE-TSO-0005 

operatorLabel TSO name Gasunie Deutschland Transport 
Services GmbH 

tsoEicCode EIC code of the TSO. The EIC code 
of the TSO may change over time. 

21X-DE-D-A0A0A-K 

directionKey Flow direction (Entry or Exit) Entry 

adjacentSystemsKey Unique ID of the adjacent system 
to the balancing zone. 

Production 

adjacentSystemsLabel Adjacent system name Production 

year Year of the date for which the 
information is exported. 

2016 

month Name of the month for which the 
information is exported: 

2 



1: January 
2: February 
…. 
11: November 
12: December 

day Date of the month for which the 
information is exported. 

18 

unit Units in which the indicator value is 
presented (kWh/d, kWh/h, 
kWh/m³, etc.) 

kWh/d 

value Value of the exported indicator 81666593 

countPointPresents Total number of points for which 
the indicator values is aggregated. 

2 

flowStatus The status of the information 
(Provisional or Confirmed) 

Provisional 

pointsNames List of the points which were 
aggregated to produce the data 
item, separated by “|” as delimiter. 

Production (DE) (GUD) H-Gas-
Summe Produktion|Production 
(DE) (GUD) L-Gas-Summe 
Produktion 

lastUpdateDateTime The date of the publication of the 
information. 

2016-02-23 12:46 
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CMP UNSUCCESSFUL 
REQUEST EXPORT FIELDS 

MEANING OF THE FIELD TITLE POSSIBLE VALUES / EXAMPLE 

periodFrom Start of the period for which the 
information is valid. 
The hour is shown in the time zone 
selected by the TP user. 

2015-01-01 00:00 

periodTo End of the period for which the 
information is valid. 
The hour is shown in the time zone 
selected by the TP user. 

2015-03-31 00:00 

operatorKey Unique ID of the TSO in the TP 
Database.  
Contrary to the EIC codes, this ID 
can never change. 

FR-TSO-0003 

tsoEicCode EIC code of the TSO.  
The EIC code of the TSO may 
change over time. 

21X-FR-A-A0A0A-S 

operatorLabel TSO name GRTGaz 

pointKey Unique ID of the point in the TP 
Database.  
Contrary to the EIC codes, this ID 
can never change. 

ITP-00163 



pointLabel Name of the point Liaison Nord Sud 

tsoItemIdentifier Code used by the TSO for data 
publication for a point.  
Since October 2015, only EIC codes 
are used as point identifiers on 
ENTSOG TP.  

21Z000000000166L 

directionKey Flow direction (Entry or Exit) Exit 

unit Units in which the indicator value is 
presented (kWh/d, kWh/h, 
kWh/m³, etc.) 

kWh/d 

itemRemarks Item specific optional remark, 
which can be visualized in the 
exports.  

Remark text could appear here if 
published by the TSO 

generalRemarks In case of an absence of 
occurrences of unsuccessful 
requests for firm capacity products 
with duration of one month or 
longer, the TSOs publish remark 
containing explanation of the case. 
The explanation is provided 
through sentences harmonized 
among the TSOs,  
 
i.e: “Currently there are no 
requests for firm capacity products 
on this point with duration of one 
month or longer that weren't 
successfully fulfilled.” 
 
The field is empty, in case of 
occurrences of unsuccessful 
requests for firm capacity products 
with duration of one month or 
longer and then information in the 
fields “requestedVolume”, 
“allocatedVolume”, 
“unallocatedVolume” and 
“occurenceCount” is published. 

 

requestedVolume Requested capacity 26094888 

allocatedVolume Allocated capacity 1513200 

unallocatedVolume Unallocated capacity 24581688 

lastUpdateDateTime The date of the publication of the 
information. 

2016-01-27 18:12 

occurenceCount Number of occurrences of 
unsuccessful requests for firm 
capacity during the pointed period. 

31 



indicator The indicator is not relevant for 
this dataset. 

Example not applicable. 

periodType The indicator is not relevant for 
this dataset. 

Example not applicable. 

isUnlimited The indicator is not relevant for 
this dataset. 

Example not applicable. 

flowStatus The indicator is not relevant for 
this dataset. 

Example not applicable. 

interruptionType The indicator is not relevant for 
this dataset. 

Example not applicable. 

restorationInformation The indicator is not relevant for 
this dataset. 

Example not applicable. 

capacityType The indicator is not relevant for 
this dataset. 

Example not applicable. 

capacityBookingStatus The indicator is not relevant for 
this dataset. 

Example not applicable. 

value The indicator is not relevant for 
this dataset. 

Example not applicable. 

id Technical identifier which is a 
unique fingerprint of the data item. 

22014-12-31 23:00:00 
+00:002015-03-30 22:00:00 
+00:00FR-TSO-0003ITP-
00163ExitkWh/d 

dataSet Datasets represent groups of 
similar data items. Possible values: 
1: Transport Data indicators. 
2: CMP Unsuccessful Requests 
3: CMP Auctions 
4: CMP Unavailable 
5: Detailed Interruption data 
The value of the field shows the 
type of exported data set. 

2 

isCamRelevant TRUE if the point is CAM-relevant. 
FALSE if the point is NON-CAM-
relevant. 

TRUE 

isNA The indicator is not relevant for 
this dataset. 

Example not applicable. 

originalPeriodFrom The indicator is not relevant for 
this dataset. 

Example not applicable. 
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CMP AUCTION RESULTS  
EXPORT FIELDS 

MEANING OF THE FIELD TITLE POSSIBLE VALUES / EXAMPLE 

auctionFrom Start of the auction slot 2016-01-18 09:00 

auctionTo End of the auction slot 2016-02-10 14:00 



capacityFrom Start of the period for which the 
capacity was auctioned. 

2016-03-01 06:00 

capacityTo End of the period for which the 
capacity was auctioned. 

2016-04-01 06:00 

operatorKey Unique ID of the TSO in the TP 
Database. Contrary to the EIC 
codes, this ID can never change. 

DE-TSO-0004 

tsoEicCode EIC code of the TSO. The EIC code 
of the TSO may change over time. 

21X000000001008P 

operatorLabel TSO name GRTgaz Deutschland 

pointKey Unique ID of the point in the TP 
Database. Contrary to the EIC 
codes, this ID can never change. 

ITP-00056 

pointLabel Name of the point Oberkappel (GRTgaz D) 

tsoItemIdentifier Code used by the TSO for data 
publication for a point.  
Since October 2015, only EIC codes 
are used as point identifiers on 
ENTSOG TP.  

21Z000000000161V 

directionKey Flow direction (Entry or Exit) Exit 

unit Units in which the indicator value is 
presented (kWh/d, kWh/h, 
kWh/m³, etc.) 

EUR/kWh/h 

itemRemarks Item specific optional remark, 
which can be visualized in the 
exports.  

Remark text could appear here if 
published by the TSO 

generalRemarks In case of absence of occurrences 
of auctions when firm capacity 
products with a duration of one 
month or longer have cleared at 
prices higher than the reserve 
price, the TSOs publish remark 
containing an explanation of the 
case. The explanation is provided 
through sentences harmonized 
among the TSOs, 
 
i.e: “Currently there are no firm 
capacity products on this point with 
a duration of one month or longer 
auctioned having cleared with an 
auction premium”.  
 
The field is empty, in case of 
occurrences of auctions when firm 
capacity products with a duration 

 



of one month or longer have 
cleared at prices higher than the 
reserve price and then information 
in the fields “auctionPremium”, 
“clearedPrice”, “reserveprice” is 
published. 

auctionPremium Auction premium 0.080151 

clearedPrice Cleared price 0.396948 

reservePrice Reserve price 0.316797 

lastUpdateDateTime The date of the publication of the 
information. 

2016-03-01 10:38 

id Technical identifier which is a 
unique fingerprint of the data item. 

32016-01-18 08:00:00 
+00:002016-02-10 13:00:24 
+00:002016-03-01 05:00:00 
+00:002016-04-01 04:00:00 
+00:00DE-TSO-0004ITP-
00056exitEUR 

dataSet Datasets represent groups of 
similar data items. Possible values 
for the CMP related exports: 
1: Transport Data indicators. 
2: CMP Unsuccessful Requests 
3: CMP Auctions 
4: CMP Unavailable 
5: Detailed Interruption data 

3 
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CMP CAPACITY MADE 
AVAILABLE EXPORT FIELDS 

MEANING OF THE FIELD TITLE POSSIBLE VALUES / EXAMPLE 

id Technical identifier which is a 
unique fingerprint of the data item. 

1Available through UIOLI short-
termkWh/ddayDE-TSO-0010ITP-
00007entrykWh/d2016-02-
182016-02-19 

dataSet Datasets represent groups of 
similar data items. Possible values: 
1: Transport Data indicators. 
2: CMP Unsuccessful Requests 
3: CMP Auctions 
4: CMP Unavailable 
5: Detailed Interruption data 

1 



The value of the field shows the 
type of exported data set. 

indicator The CMP procedure that has been 
applied for providing capacity in 
case of contractual congestion. 
Possible values: 
- Available through UIOLI short-

term; 
- Available through 

Oversubscription; 
- Available through Surrender; 
- Available through UIOLI long-

term. 

Available through UIOLI short-
term 

periodType Period Type (Day or Hour) - 
presents the granularity of the 
data. 

Day 

periodFrom Start of the period for which the 
information is valid. 

2016-02-18 06:00 

periodTo End of the period for which the 
information is valid. 

2016-02-19 06:00 

operatorKey Unique ID of the TSO in the TP 
Database.  
Contrary to the EIC codes, this ID 
can never change. 

DE-TSO-0010 

tsoEicCode EIC code of the TSO.  
The EIC code of the TSO may 
change over time. 

21X-DE-A-A0A0A-A 

operatorLabel TSO name Bayernets 

pointKey Unique ID of the point in the TP 
Database. Contrary to the EIC 
codes, this ID can never change. 

ITP-00007 

pointLabel Name of the point Überackern SUDAL (AT) / 
Überackern 2 (DE) 

tsoItemIdentifier Code used by the TSO for data 
publication for a point.  
Since October 2015, only EIC codes 
are used as point identifiers on 
ENTSOG TP.  

21Z0000000001240 

directionKey Flow direction (Entry or Exit) entry 



unit Units in which the indicator value is 
presented (kWh/d, kWh/h, 
kWh/m³, etc.) 

kWh/d 

itemRemarks Item specific optional remark, 
which can be visualized in the 
exports. 

Remark text could appear here if 
published by the TSO 

generalRemarks In case of an absence of 
occurrences when capacity was 
made available through the 
application of the congestion-
management procedures, the TSOs 
publish remark containing an 
explanation of the case. The 
explanation is provided through 
sentences harmonized among the 
TSOs,  
 
i.e: “Currently there are no request 
for firm capacity products on this 
point with a duration of one month 
or longer that weren't successfully 
fulfilled”.  
 
The field is empty, in case of 
occurrences when capacity was 
made available through the 
application of the congestion-
management procedures, and then 
the field “value” contains 
information about the capacity 
made available through the 
application of the procedure 
pointed in the “indicator” field. 

 

value Value of the capacity made 
available through the application of 
the pointed CMP procedure for the 
particular period and point. 

16134528 

lastUpdateDateTime The date of the publication of the 
information. 

2016-02-19 10:52 

isUnlimited The indicator is not relevant for 
this dataset. 

Example not applicable. 

flowStatus The indicator is not relevant for 
this dataset. 

Example not applicable. 

interruptionType The indicator is not relevant for 
this dataset. 

Example not applicable. 

restorationInformation The indicator is not relevant for 
this dataset. 

Example not applicable. 



capacityType The indicator is not relevant for 
this dataset. 

Example not applicable. 

capacityBookingStatus The indicator is not relevant for 
this dataset. 

Example not applicable. 

isCamRelevant TRUE if the point is CAM-relevant. 
FALSE if the point is NON-CAM-
relevant. 

TRUE 

isNA The indicator is not relevant for 
this dataset. 

Example not applicable. 

originalPeriodFrom The indicator is not relevant for 
this dataset. 

Example not applicable. 

isDefaultSentence TRUE if the data item does not 
represent actual data, but the 
default sentence chosen by the TSO 
to indicate the reason.  

FALSE 

defaultSentence The default sentence chosen by the 
TSO to indicate why no actual data 
can be provided. The field content 
is depends of the value of the field 
“isDefaultSentence”. The field 
“defaultSentence “ is populated 
when the field  “isDefaultSentence” 
value is equal to TRUE.  
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CMP UNAVAILABLE FIRM 
EXPORT FIELDS 

MEANING OF THE FIELD TITLE POSSIBLE VALUES / EXAMPLE 

periodFrom Start of the period for which the 
information is valid (start of the gas 
day or gas hour).  
The hour is shown in the time zone 
selected by the TP user. 

2015-10-01 06:00 

periodTo End of the period for which the 
information is valid (end of the gas 
day or gas hour). 
The hour is shown in the time zone 
selected by the TP user. 

2016-10-01 06:00 

operatorKey Unique ID of the TSO in the TP 
Database. Contrary to the EIC 
codes, this ID can never change. 

DE-TSO-0010 

tsoEicCode EIC code of the TSO. The EIC code 
of the TSO may change over time. 

21X-DE-A-A0A0A-A 

operatorLabel Abbreviation of the TSO name Bayernets 

pointKey Unique ID of the point in the TP 
Database. Contrary to the EIC 
codes, this ID can never change. 

ITP-00007 



pointLabel Name of the point Überackern SUDAL (AT) / 
Überackern 2 (DE) 

tsoItemIdentifier Code used by the TSO for data 
publication for a point.  
Since October 2015, only EIC codes 
are used as point identifiers on 
ENTSOG TP.  

21Z0000000001240 

directionKey Flow direction (Entry or Exit) entry 

allocationProcess The regular allocation process 
applied at the point for the 
particular period.  
Possible values: 
- Auction; 
- FCFS; 
- OpenSubscription. 

Auction 

itemRemarks Item specific optional remark, 
which can be visualized in the 
exports.  

Remark text could appear here if 
published by the TSO 

generalRemarks In case of an absence of 
occurrences when no firm capacity 
product with a duration of one 
month or longer has been offered 
in the regular allocation process, 
the TSOs publish remark containing 
explanation of the case. The 
explanation is provided through 
sentences harmonized among the 
TSOs,  
 
i.e: “Currently firm products with a 
duration of one month or longer 
are offered on this point in the 
regular allocation process”.  
 
The field is empty in case of 
occurrences when no firm capacity 
product with a duration of one 
month or longer has been offered 
in the regular allocation process 
pointed in the field 
“allocationProcess”. 

 

lastUpdateDateTime The date of the publication of the 
information. 

2016-01-27 18:12 

id Technical identifier which is a 
unique fingerprint of the data item. 

42015-10-01 04:00:00 
+00:002016-10-01 04:00:00 
+00:0021X-DE-A-A0A0A-ADE-
TSO-0010ITP-00007entryAuction 



dataSet Datasets represent groups of 
similar data items.  
Possible values: 
1: Transport Data indicators. 
2: CMP Unsuccessful Requests 
3: CMP Auctions 
4: CMP Unavailable 
5: Detailed Interruption data 
The value of the field shows the 
type of exported data set. 

4 

indicator The indicator is not relevant for 
this dataset. 

Example not applicable. 

periodType The indicator is not relevant for 
this dataset. 

Example not applicable. 

unit The indicator is not relevant for 
this dataset. 

Example not applicable. 

value The indicator is not relevant for 
this dataset. 

Example not applicable. 

isUnlimited The indicator is not relevant for 
this dataset. 

Example not applicable. 

flowStatus The indicator is not relevant for 
this dataset. 

Example not applicable. 

interruptionType The indicator is not relevant for 
this dataset. 

Example not applicable. 

restorationInformation The indicator is not relevant for 
this dataset. 

Example not applicable. 

capacityType The indicator is not relevant for 
this dataset. 

Example not applicable. 

capacityBookingStatus The indicator is not relevant for 
this dataset. 

Example not applicable. 

isCamRelevant TRUE if the point is CAM-relevant. 
FALSE if the point is NON-CAM-
relevant. 

TRUE 

isNA The indicator is not relevant for 
this dataset. 

Example not applicable. 

originalPeriodFrom The indicator is not relevant for 
this dataset. 

Example not applicable. 
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Tariff Full  MEANING OF THE FIELD TITLE POSSIBLE VALUES / EXAMPLE 

Tariff Period Describes the tariff period for 
which the record is valid  

2017-01-01T06:00:00+01:00 - 
2018-01-01T06:00:00+01:00 



Tariff Period Remarks Comments to the tariff period This tariff period lasts from 
February 1st 2017 - January 1st 
2018. 

Point Name Name of the point for which the 
record is valid.  

Wallbach 

Point Identifier (EIC) EIC code of the point for which the 
record is valid 

21Z0000000001216 

Direction Flow direction for which the record 
is valid 

Exit 

Operator TSO operating the point for which 
the record is valid 

Fluxys TENP 

 

Country code Short name for the country where 
the point is located in.  

DE 

Connection Describes which other operators 
are operating the point.  

Fluxys TENP -> Swissgas, Fluxys 
TENP -> FluxSwiss, Fluxys TENP -> 
Open Grid Europe 

Remarks fo connection Remarks elaborating on the 
connection of operators at a point.  

 

From BZ Describes the start balancing zone 
(depending on the flow direction).  

BeLux 

 

To BZ Describes the end balancing zone 
(depending on the flow direction) 

NCG 

 

Start time of validity  Describes the starting point in time 
when a given tariff is valid.  

2017-01-01T06:00:00+01:00 

 

End time of validity  Describes the ending point in time 
when a given tariff ceases to be 
valid. 

2018-01-01T06:00:00+01:00 

 

Capacity Type Describes if the capacity type for 
which the record is valid is firm or 
interruptible 

Firm  

Unit Describes the relevant unit of the 
capacity type for which the record 
is valid  

kWh/h 



Product type according to its 
duration 

Describes the duration of the 
product for which the record is 
valid. On the TP you may find 
yearly, quarterly, monthly, daily 
and withinday products in the tariff 
section.  

Yearly 

Multiplier Factor applied to the respective 
proportion of the reference price in 
order to calculate the reserve price 
for a non-yearly standard capacity 
product 

1.25000000 

Remarks for multiplier  Multiplier for monthly products. 

Discount for interruptible 
capacity 

Probability for interruption of 
interruptible capacity, expressed as 
a value 0-1 or NA 

0.30000000 

Remarks for discount Explanation to support the user in 
understanding the applied 
discount.  

30% discount 

 

Seasonal factor Factor reflecting the variation of 
demand within the year which may 
be applied in combination with the 
relevant multiplier.  

0.65000000 

Remarks for seasonal factor Explanation to support the user in 
understanding the applied seasonal 
factor. 

Seasonal factor for Q2 (Apr-Jun) 

Operator Currency The currency in which the tariffs 
are settled.  

CZK 

Applicable tariff per kWh/d 
(local) 

The value of the tariff in a daily 
capacity unit in local currency.  
 

0.01393269 

Local Currency/ kWh/d The full unit for the tariff in a daily 
capacity unit and the settlement 
period in local currency.  

CZK/(kWh/d)/h 

Applicable tariff per kWh/h 
(local) 

The value of the tariff in an hourly 
capacity unit in local currency.  
 

0.33438456 

Local Currency/ kWh/h  The full unit for the tariff in an 
hourly capacity unit and the 
settlement period in local currency.  

CZK/(kWh/h)/h 

Applicable tariff per kWh/d 
(Euro) 

The value of the tariff in a daily 
capacity unit in euros.  
 

0.10833337 



EUR / kWh/d The full unit for the tariff in a daily 
capacity unit and the settlement 
period in euros.  

Euro/(kWh/d)/y 

Applicable tariff per kWh/h 
(Euro) 

The value of the tariff in an hourly 
capacity unit in euros.  
 

2.60000085 

EUR / kWh/h The full unit for the tariff in an 
hourly capacity unit and the 
settlement period in euros.  

Euro/(kWh/h)/y 

Remarks for applicable tariff Comments pertaining to the 
previous 8 fields describing the 
applicable tariffs for standard 
products in hourly and daily 
capacity units, in local currency and 
euros.  

A zero tariff currently applies for 
Capacity and Commodity. A 
registration fee of €26,253 per 
shipper applies at the point. 
https://www.cru.ie/wp-
content/uploads/2016/08/CER17
275-Gas-Transmission-Tariffs-
2017_18-Decision-Paper.pdf 

Applicable tariff in common 
unit 

Value of the tariff in a common 
unit. The common unit is added as 
additional information for 
harmonisation purposes (principle 
of the greatest common divisor to 
allow every TSO to convert its 
tariffs into the common unit).  

0.00008300 

EUR/kWh/h/d for all products 
EUR/kWh/h/h for within-day 

Shows which of the two possible 
units are applicable to the value in 
the previous field.  

Euro/(kWh/h)/h 

Remarks for applicable tariff 
in common unit 

Field for adding further explanation 
to the common unit.  

The applicable tariff in common 
unit is provided for comparison 
reasons only. 

Applicable commodity tariff 
per kWh, if any, in the Local 
Currency  

Value for a commodity tariff, also 
know as flow-based charges, in 
local currencies.  

0.00030992 

Applicable commodity tariff 
per kWh, if any, in the EURO 

Value for a commodity tariff, also 
know as flow-based charges, in 
euros. 

0.00030992 

Remarks for applicable 
commodity 

Further explanation to the 
commodity tariff.  

The commodity tariff approved 
for year 2017 is equal to 
0,003375 E/scm   and it is applied 
to physical volumes. The value 
shown has been   converted in 
E/kWh using a weighted average 
GCV for the Thermal Year   
2017/18. 



Last Update Date The date and time when the record 
was last updated.  

2017-12-15 12:15 

Exchange Rate Reference 
Date 

The date and time when the 
calculations from local currencies 
to euros was last performed. 

2017-12-20T04:19:29+01:00 

Remarks General remark field relating to the 
record in general.  

This is a Virtual Interconnection 
Point. This point consists of 
Lwowek  (21Z000000000167J ) 
and Wloclawek 
(21Z000000000168H). 

Operator key Unique ID of the TSO in the TP 
Database.  
Contrary to the EIC codes, this ID 
can never change. 

PL-TSO-0001 

Tso Eic code  EIC code of the TSO. The EIC code 
of the TSO may change over time. 

21V000000000003V 

Point key Unique ID of the point in the TP 
Database.  
Contrary to the EIC codes, this ID 
can never change. 
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 TARIFF SIMULATION – EXPORT FIELDS 2346 

 2347 

TARIFF Simulation  MEANING OF THE FIELD TITLE POSSIBLE VALUES / EXAMPLE 

Tariff Period Describes the tariff period for 
which the record is valid  

2017-01-01T06:00:00+01:00 - 
2018-01-01T06:00:00+01:00 

Tariff Period Remarks Comments to the tariff period This tariff period lasts from 
February 1st 2017 - January 1st 
2018. 

Point Name Name of the point for which the 
record is valid.  

Wallbach 

Point Identifier (EIC) EIC code of the point for which the 
record is valid 

21Z0000000001216 

Direction Flow direction for which the record 
is valid 

Exit 

Operator TSO operating the point for which 
the record is valid 

Fluxys TENP 

 



Country code Short name for the country where 
the point is located in.  

DE 

Connection Describes which other operators 
are operating the point.  

Fluxys TENP -> Swissgas, Fluxys 
TENP -> FluxSwiss, Fluxys TENP -> 
Open Grid Europe 

Remarks fo connection Remarks elaborating on the 
connection of operators at a point.  

 

From BZ Describes the start balancing zone 
(depending on the flow direction).  

BeLux 

 

To BZ Describes the end balancing zone 
(depending on the flow direction) 

NCG 
 

Capacity Type Describes if the capacity type for 
which the record is valid is firm or 
interruptible 

Firm  

Unit Describes the relevant unit of the 
capacity type for which the record 
is valid  

kWh/h 

Product type according to its 
duration 

Describes the duration of the 
product for which the record is 
valid. On the TP you may find 
yearly, quarterly, monthly, daily 
and withinday products in the tariff 
section.  

Yearly 

Operator Currency The currency in which the tariffs 
are settled.  

CZK 

Simulation of all the costs foe 
flowing 1 GWh/day/year in 
Local currency 

Simulation of all the costs for 
flowing 1 GWh/day/year in Local 
currency. This value is based on the 
average price for quarterly 
products.  

615341.00000000 

Simulation of all the costs for 
flowing 1 GWh/day/year in 
EUR 

Simulation of all the costs for 
flowing 1 GWh/day/year in Local 
currency. This value is based on the 
average price for quarterly 
products.  

146366.87995053 

Remars for Simulation costs Additional explanation for how the 
TSO has calculated the simulation, 
including listing the parameters 
which are taken into account.  

The costs include capacity 
charges, commodity charges and 
transmission costs. 



Last Update Date The date and time when the record 
was last updated.  

2017-12-15 12:15 

Exchange Rate Reference 
Date 

The date and time when the 
calculations from local currencies 
to euros was last performed. 

2017-12-20T04:19:29+01:00 

Remarks General remark field relating to the 
record in general.  

This is a Virtual Interconnection 
Point. This point consists of 
Gubin Gaz-System - PL / Guben 
ONTRAS DE 
(21Z000000000089D) and Lasów 
(EIC 21Z000000000057Q). 

Operator key Unique ID of the TSO in the TP 
Database.  
Contrary to the EIC codes, this ID 
can never change. 

PL-TSO-0001 

Tso Eic code  EIC code of the TSO. The EIC code 
of the TSO may change over time. 

21V000000000003V 

Point key Unique ID of the point in the TP 
Database.  
Contrary to the EIC codes, this ID 
can never change. 
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 2350 
 2351 

How to open a CSV document in XLS/XLSX (MS Excel) file? 2352 

 2353 

Once you have exported the information of your interest in CSV file format you could easily open and save 2354 

it in XLS/XLSX (MS Excel) format. 2355 

There are many possibilities. Two of them are presented in the examples below. 2356 

 2357 

 2358 

 2359 
 2360 

Follow the next 3 steps: 2361 

1. Click with the right mouse button on the file in CSV format; 2362 

2. Press on Open with and 2363 

3. Select MS Excel. 2364 



 2365 

 2366 
 2367 

 2368 

 2369 
 2370 

Another possibility is to open and convert a CSV file that you exported form ENTSOG TP in XLS/XLSX (MS 2371 

Excel) format is to use the Open command of MS Excel.  2372 

 2373 

1. Open MS Excel;  2374 

2. On the Data tab, in the Get External Data group, click From Text. Then, in the Import Text File 2375 

dialog box, browse to the CSV file that you exported form ENTSOG TP and double-click on it. 2376 

3. Follow the Text Import Wizard steps: 2377 

 2378 

Step 1: Set the following settings:  2379 

Original data type: Delimited 2380 

File origin: Windows (ANSI) 2381 

 2382 

 2383 



 2384 
 2385 

 2386 

Step 2: Set the following settings: 2387 

Delimiters: Select Comma 2388 

Text qualifier: Leave the default option quotation mark (") 2389 

 2390 

 2391 
 2392 

 2393 



Step 3: Set the following settings: 2394 

Column Data Format: General 2395 

Select FINISH. 2396 

 2397 

 2398 
 2399 

 2400 

 2401 
 2402 

Opening a text file (*.CSV or *.TXT) in MS Excel does not change the format of the file — you can see this 2403 

in the Excel title bar, where the name of the file retains the text file name extension (for example, .txt or 2404 

.csv). 2405 

 2406 

To convert the opened CSV file in XLS/XLSX format, go to File menu, select Save as option: 2407 

 2408 

 2409 
 2410 

and Save the file as: 2411 



Excel Workbook (*.xlsx) or  2412 

Excel 97-2003 Workbook (*.xls): 2413 

 2414 

 2415 
 2416 

 2417 

 2418 
 2419 

You can apply some filtering options on the extracted data by the using the MS Excel option Sort & Filter. 2420 

Go to Home menu, select Sort & Filter and press on Filter option. 2421 

 2422 

 2423 
 2424 

Filtering controls (Arrow  sign) automatically are added to the table headers.  2425 

For quick filtering, do this: 2426 

 2427 

 2428 



1. Click the arrow  in the table header of the column you want to filter. 2429 

2. In the list of text or numbers on the drop-down many that appears, uncheck the (Select All) box 2430 

at the top of the list, and then check the boxes of the items you want to show in your table.  2431 

 2432 

 2433 
 2434 

 2435 

 2436 

 2437 

 2438 

 2439 

 2440 

 2441 

 2442 

 2443 

 2444 

 2445 

 2446 

 2447 

 2448 

 2449 

 2450 

 2451 

 2452 

 2453 

 2454 



 ZONES DATA PANEL TABS 2455 

 2456 

 ZONE DATA INDICATORS 2457 

 2458 

THE INDICATORS FOR WHICH DATA COULD BE DISPLAYED FOR A ZONE ARE: 2459 

 2460 

▪ Physical flow – aggregated physical flow in entry or exit direction (to or from) the zone; 2461 

▪ Allocations – aggregated allocated quantities in entry or exit direction of the zone; 2462 

▪ Nominations – aggregated nominated capacity at all entry or at all exit points to or from the zone. 2463 

 2464 

 2465 
 2466 

 2467 

 ZONES TAB 2468 

 2469 

In the Zones tab information about the selected zone(s) and indicator(s) (physical flow, allocation data, 2470 

nomination information) is presented in graphical way: 2471 

 2472 

 2473 
 2474 

 2475 

The list of the selected zones, including the names of the operators and adjacent zones, as well as the 2476 

indicator for which the data is displayed on the graph, are listed below the data panel: 2477 

 2478 



 2479 
 2480 

 2481 

 TRANSPORT DATA TAB 2482 

 2483 

In the Transport data tab the information about the selected zones(s) and indicator(s) in numerical way is 2484 

presented: 2485 

 2486 

 2487 
 2488 

 2489 

 2490 

 2491 

 2492 



 2493 
 2494 

The information presented on the Transport data panel can be sorted based on one or several parameters 2495 

simultaneously: 2496 

 2497 

 2498 
 2499 

The sorting could be done based on: 2500 

▪ Country name; 2501 

▪ Balancing zone name; 2502 

▪ Operator name; 2503 

▪ Direction; 2504 

▪ Adjacent system name; 2505 

▪ Validity period; 2506 

▪ Indicator; 2507 

▪ Value; 2508 

▪ Number of Aggregated points; 2509 

▪ Update date. 2510 

 2511 

To sort the data based on one parameter, simply press on the name of the parameter on the Parameter 2512 

bar. 2513 

The sorting functionalities at Zone Transport data tab are similar to the sorting possibilities of Points 2514 

Transport data Tab. For more details, please go to point 7.4.2.  2515 

 2516 

 2517 

 EXPORT WIZARD TAB 2518 

 2519 

The Export Wizard Tab leads the users to the TP Export Tool. The TP Export Tool allows manual export of 2520 

points and zones information.  2521 

The functionalities and the points information export options are explained in the next points: 7.4.6.1 to 2522 

7.4.6.3. 2523 

The functionalities and states of the zones information export tool repeat these of the points’ information 2524 

export tool.  2525 

 2526 

Through the Export wizard the TP users can export information in CSV, XLSX and XML format. The users 2527 

can choose to export information either for all zones defined on the TP or by selecting a TSO for whose 2528 

balancing zone(s) the data to be exported.  2529 

For description of the zone’s information exportable through TP Export Wizard, please refer to point 2530 

7.4.6.3. 2531 



 2532 
 2533 

 2534 

 REDIRECTION OPTIONS 2535 

 2536 

How to access the TP Map from TP Data part without losing the currently displayed information? 2537 

 2538 

If you are currently exploring information at TP Data part for one or more points but you need to check 2539 

something on the TP Map and return again to the Data graph, Transport data or whatsoever of the 2540 

displayed Data Tabs follow the next steps: 2541 

▪ Move the mouse cursor on the Point menu without clicking on it. When the drop-down menu 2542 

appears, click on the Map: 2543 

 2544 

 2545 



▪ To Return from the TP Map to the previously displayed data – move again the mouse cursor on the 2546 

Point menu and on the drop-down menu, click on the Data: 2547 

 2548 

 2549 
 2550 

 2551 

 2552 

 2553 

 2554 

 2555 

 2556 

 2557 

 2558 

 2559 

 2560 

 2561 

 2562 

 2563 

 2564 

 2565 

 2566 

 2567 

 2568 

 2569 

 2570 

 2571 

 2572 

 2573 

 2574 

 2575 

 2576 

 2577 

 2578 



8. FEEDBACK 2579 

 2580 

 2581 

Dear ENTSOG TP User,  2582 

 2583 

We would like to thank you for your interest to our Transparency Platform.   2584 

 2585 

You have now reached the end of this manual. We hope you have found it useful. 2586 

We would appreciate your feedback and suggestions on how to improve its content and to facilitate your 2587 

experience with the ENTSOG Transparency Platform. 2588 

 2589 

Should you require more examples or details on any specific parts of the manual, please do not hesitate 2590 

to contact us by using the following email: 2591 

 2592 

transparency@entsog.eu 2593 

 2594 

Kind regards,  2595 

 2596 

ENTSOG TP Development team 2597 


